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 DCI-V connection
The transceiver’s operating frequency, mode, VFO and memory selection, can be remotely controlled using a PC.
The Icom Communications Interface V (CI-V) controls the transceiver.
Select your connection method from the following:
 •  A USB cable

  The required USB driver and driver installation guide can 
be downloaded from the Icom web site.

  Go to “ https://www.icomjapan.com/support ,” and then 
click “Firmware / Software”
L The download procedure on the web page may be changed 

without notice.
L Make the connection as short as possible. The transceiver 

may not be recognized by the controller, depending on the 
USB cable length.

 • The optional OPC-2350LU (DATA CABLE)

NOTE: Before you start sending data, be sure to set the 
following items.
•  Set “DATA Function” to “CI-V.” 

(SET > Connectors > USB (B)/DATA Function)

 • The optional CT-17 (CI-V LEVEL CONVERTER)
 Connects to a PC with an RS-232C port.’

 ■ Remote control (CI-V) information

 • Connection example

To a USB port

To the [USB] port
(Type-B)

PC

USB cable

OPC-2350LU

To the [DATA] jack

To a USB port

PC

 • Connection example

IC-9700

DC 9 V ～15 V

ct-17

To the [REMOTE] jack

mini-plug cable

RS-232C
cable

PC

 • Connection example



 DPreparing
The Icom Communications Interface V (CI-V) is used for remote control.
To control the transceiver, first set its address, data communication speed, and transceive function.
These settings are set in the Set mode (Refer to the IC-9700 instruction manual). 

 DAbout the data format
The CI-V system can be written using the following data formats. Data formats differ according to command 
numbers. A data area or sub command is added for some commands. 

Controller to IC-9700

IC-9700 to controller
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OK message to controller

NG message to controller

 ■ Remote control (CI-V) information(Continued)
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Cmd. Sub cmd. Data Description
00 See p. 13 Send the frequency data (transceive)
01 See p. 13 Send the mode data (transceive)
02*1 See p. 13 Read the band edge frequencies

03*1 See p. 13 Read the operating frequency

04*1 See p. 13 Read the operating mode

05*2 See p. 13 Set the operating frequency

06*2 See p. 13 Set the operating mode
07 Select the VFO mode

00 Select VFO A
( In the satellite mode, selects the VFO 
mode.)

01 Select VFO B
(In the satellite mode, “FA” (NG) is returned.)

A0 Equalize VFO A and VFO B
B0 Exchange MAIN and SUB Bands
D0 Select the main band
D1 Select the sub band
D2* 00 Send/read main band selection

01 Send/read sub band selection
08*2 Select the Memory mode

0001 to 0099 Select the Memory channel (Including the 
satellite mode)
(0001=M-CH01, 0099=M-CH99)

0100 to 0105 Select program scan edge channel  
1A/1B to 3A/3B
( 0100/0101 (1A ch/1B ch),  
0104/0105 (3A ch/3B ch))

0106, 0107 Select call channel C1/C2
(0106 (C1 ch), 0107 (C2 ch))

09 Memory write
0A Memory copy to VFO
0B Memory clear

  0C*1 See p. 13 Read frequency offset
  0D*2 See p. 13 Send frequency offset

0E 00 Cancel the scan 
01 Start a Programmed/memory scan 
02 Start a Programmed scan 
03 Start a ∂F scan 
12 Start a Fine programmed scan 
13 Start a Fine ∂F scan
22 Start a Memory scan
23 Start a Select memory scan
24 Start a Mode Select scan
Ax*2

(x=1 to 7)
Select ∂F scan span
( x=1 (±5 kHz), x=2 (±10 kHz),
 x=3 (±20 kHz), x=4 (±50 kHz),
 x=5 (±100 kHz), x=6 (±500 kHz),
 x=7 (±1 MHz))

B0*2 Clear the Select channel setting

B1*2 Set as select channel
( The previously set number by CI-V is set 
after turning power ON, or “1” is selected if 
no selection is performed.)

01 to 03 Set the channel as a Select channel
(01=SEL1, 02=SEL2, 03=SEL3)

B2*2 00 to 03 Set the Select memory scan channel
(00=ALL, 01=SEL1, 02=SEL2, 03=SEL3)

D0*2 Set Scan resume OFF

D3*2 Set Scan resume ON (Close&Delay)
0F *1 00 Read Split OFF setting

01 Read Split ON setting
11 Read DUP– operation
12 Read DUP+ operation
13 Read DD Repeater Simplex mode (RPS)

00*2 Set Split function OFF

01*2 Set Split function ON

Cmd. Sub cmd. Data Description
0F 10*2 Set the simplex operation

11*2 Set DUP– operation

12*2 Set DUP+ operation

13*2 Set DD Repeater Simplex mode (RPS)
10* 00 to 11 Send/read the tuning step

( 00=OFF (10 Hz or 1 Hz),
 01=100 Hz, 02=500 Hz, 03=1 kHz, 
 04=5 kHz, 05=6.25 kHz, 06=10 kHz, 
 07=12.5 kHz, 08=20 kHz, 09=25 kHz,
 10=50 kHz, 11=100 kHz)

11* 00 Send/read attenuator OFF setting
10 Send/read 10 dB attenuator setting

13 00 Speech all data with voice synthesizer
(S meter level, frequency and mode)

01 Speech the operating frequency and S meter 
level by voice synthesizer

02 Speech the operating mode by voice synthesizer
L The mode is announced after the ongoing 

speech.
14* 01 0000 ~ 0255 Send/read the AF level 

(0000=Minimum to 0255=Maximum)
02 0000 ~ 0255 Send/read the RF gain level

(0000=Minimum to 0255=Maximum)
03 0000 ~ 0255 Send/read the squelch level

(0000=Minimum to 0255=Maximum)
06 0000 ~ 0255 Send/read the NR level

(0000=0%, 0255=100%)
07 0000 ~ 0255 Send/read [TWIN PBT] (PBT1) position

( 0000=max. Counter Clockwise, 0128=center, 
0255=max. Clockwise)

08 0000 ~ 0255 Send/read [TWIN PBT] (PBT2) position
( 0000=max. Counter Clockwise, 0128=center, 
0255=max. Clockwise)

09 0000 ~ 0255 Send/read CW pitch (5 Hz steps)
( 0000=300 Hz, 0128=600 Hz, 0255=900 Hz)

0A 0000 ~ 0255 Send/read RF power 
( 0000=Minimum to 0255=Maximum)

0B 0000 ~ 0255 Send/read MIC gain
(0000=Minimum to 0255=Maximum)

0C 0000 ~ 0255 Send/read keying speed
(0000=6 WPM to 0255=48 WPM)

0D 0000 ~ 0255 Send/read Notch filter setting
( 0000=max. Counter Clockwise, 0128=center, 
0255=max. Clockwise)

0E 0000 ~ 0255 Send/read the COMP level
(0000=0 to 0255=10)

0F 0000 ~ 0255 Send/read the Break-IN Delay setting
(0000=2.0 d to 0255=13.0 d)

12 0000 ~ 0255 Send/read NB level
(0000=0% to 0255=100%)

15 0000 ~ 0255 Send/read Monitor audio [MONI] level
(0000=0% to 0255=100%)

16 0000 ~ 0255 Send/read the VOX gain
(0000=0% to 0255=100%)

17 0000 ~ 0255 Send/read the Anti VOX gain
(0000=0% to 0255=100%)

19 0000 ~ 0255 Send/read LCD backlight brightness
(0000=0% to 0255=100%)

15*1 01 00 or 01 Read noise or S-meter squelch status
(00=Close, 01=Open)

02 0000 to 0255 Read S-meter level
(0000=S0, 0120=S9, 0241=S9+60 dB)

05 00 or 01 Read various squelch (tone squelch, and so 
on) status
(00=Close, 01=Open)

07 00 or 01 Read the OVF status
( 00=OVF indicator is OFF, 01=OVF indicator is ON)

11 0000 ~ 0255 Read the PO meter level
(0000=0% to 0143=50% to 0213=100%)

 DCommand table

NOTE: Operation of some control dials overrides CI-V commands. If a control dial, such as the AF Volume dial that  has 
a mark on it, is rotated after sending a CI-V command, the command will be overwritten by the operation.
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Cmd. Sub cmd. Data Description
15*1 12 0000 ~ 0255 Read SWR meter level

(   0000=SWR1.0, 0048=SWR1.5,
 0080=SWR2.0, 0120=SWR3.0)

13 0000 ~ 0255 Read ALC meter level
(0000=Minimum to 0120=Maximum)

14 0000 ~ 0255 Read COMP meter level
(0000=0 dB, 0130=15 dB, 0210=25.5 dB)

15 0000 ~ 0255 Read Vd meter level
(0000=0 V, 0013=10 V, 0241=16 V)

16 0000 ~ 0255 Read Id meter level
( 0000=0 A, 0121=10 A, 0241=20 A)

16* 02 00 to 03 Send/read the Preamp/External Preamp
(00=P.AMP (OFF)/EXT-P.AMP (OFF), 
 01=P.AMP (ON)/EXT-P.AMP (OFF), 
 02=P.AMP (OFF)/EXT-P.AMP (ON), 
 03=P.AMP (ON)/EXT-P.AMP (ON))

12 01 to 03 Send/read the AGC time constant
(01=FAST, 02=MID, 03=SLOW)

22 00 or 01 Send/read the Noise blanker
(00=OFF, 01=ON)

40 00 or 01 Send/read the Noise reduction
(00=OFF, 01=ON)

41 00 or 01 Send/read the Auto Notch function
(00=OFF, 01=ON)

42 00 or 01 Send/read the Repeater tone
(00=OFF, 01=ON)

43 00 or 01 Send/read the Tone squelch
(00=OFF, 01=ON)

44 00 or 01 Send/read the Speech compressor
(00=OFF, 01=ON)

45 00 or 01 Send/read the Monitor [MONI] function
(00=OFF, 01=ON)

46 00 or 01 Send/read the VOX function
(00=OFF, 01=ON)

47 00 to 02 Send/read the BK-IN function
( 00=BK-IN OFF, 01=Semi BK-IN ON,  
02=Full BK-IN ON)

48 00 or 01 Send/read the Manual Notch function
(00=OFF, 01=ON)

4A 00 or 01 Send/read the AFC function
(00=OFF, 01=ON)

4B 00 or 01 Send/read the DTCS function
(00=OFF, 01=ON)

4F 00 or 01 Send/read the Twin peak filter
(00=OFF, 01=ON)
( Can be turned ON only when Mark and Shift 
are set to 2125 Hz and 170 Hz, respectively)

50 00 or 01 Send/read the Dial lock function
(00=OFF, 01=ON)

56 00 or 01 Send/read the DSP IF filter type
(00=SHARP, 01=SOFT)

57 00 to 02 Send/read the Manual Notch width
(00=WIDE, 01=MID, 02=NAR)

58 00 to 02 Send/read SSB transmit bandwidth
(00=WIDE, 01=MID, 02=NAR)
( One of following values is applied, depending 
on the “COMP” status (ON or OFF):

 WIDE (Command: 1A 05 0017),  
 MID (Command: 1A 05 0018) or 
 NAR (Command: 1A 05 0019))

59 00 or 01 Send/read the sub band (the Dualwatch 
function)
(00=OFF, 01=ON)

5A 00 or 01 Send/read the satellite mode
(00=OFF, 01=ON)

5B 00 to 02 Send/read the DSQL (Digital Call Sign 
squelch)/CSQL (Digital Code squelch) setting 
(DV mode only)
( 00=OFF, 01=DSQL,02=CSQL)

5C 00 to 02 Set the GPS TX mode
(00= OFF, 01= D-PRS, 02= NMEA)

00 to 03,  
06 to 09

Set the Tone squelch function
( 00=OFF, 01=TONE, 02=TSQL, 03=DTCS,  
06=DTCS (T), 07=TONE (T)/DTCS (R),  
08=DTCS (T)/TSQL (R),  
09=TONE (T)/TSQL (R))

65 00 or 01 Set the IP Plus function
(00=OFF, 01=ON)

 D Command table (Continued)
Cmd. Sub cmd. Data Description

17*3 See p. 10 Send CW messages
18 00 Turn OFF the transceiver

01*4 Turn ON the transceiver
19*1 00 Read the transceiver ID
1A* 00 See pp. 14, 15 Send/read memory contents

01 See p. 15 Send/read band stacking register contents
02*5 See pp. 15, 16 Send/read memory keyer contents
03 See p. 16 Send/read the selected IF filter width

04 See p. 16 Send/read the selected AGC time constant

05 0001 See p. 16 SET > Tone Control/TBW > RX > 
Send/read SSB RX HPF/LPF settings

0002 00 to 10 SET > Tone Control/TBW > RX > 
Send/read SSB RX Tone (Bass) level
(00=–5 to 10=+5)

0003 00 to 10 SET > Tone Control/TBW > RX > 
Send/read SSB RX Tone (Treble) level 
(00=–5 to 10=+5)

0004 See p. 16 SET > Tone Control/TBW > RX > 
Send/read AM RX HPF/LPF settings

0005 00 to 10 SET > Tone Control/TBW > RX > 
Send/read AM RX Tone (Bass) level
(00=–5 to 10=+5)

0006 00 to 10 SET > Tone Control/TBW > RX > 
Send/read AM RX Tone (Treble) level
(00=–5 to 10=+5)

0007 See p. 16 SET > Tone Control/TBW > RX > 
Send/read FM RX HPF/LPF settings

0008 00 to 10 SET > Tone Control/TBW > RX > 
Send/read FM RX Tone (Bass) level
(00=–5 to 10=+5)

0009 00 to 10 SET > Tone Control/TBW > RX > 
Send/read FM RX Tone (Treble) level
(00=–5 to 10=+5)

0010 See p. 16 SET > Tone Control/TBW > RX > 
Send/read DV RX HPF/LPF settings

0011 00 to 10 SET > Tone Control/TBW > RX > 
Send/read DV RX Tone (Bass) level
(00=–5 to 10=+5)

0012 00 to 10 SET > Tone Control/TBW > RX > 
Send/read Auto DV RX Tone (Treble) level
(00=–5 to 10=+5)

0013 See p. 16 SET > Tone Control/TBW > RX > 
Send/read CW RX HPF/LPF settings

0014 See p. 16 SET > Tone Control/TBW > RX > 
Send/read RTTY RX HPF/LPF settings

0015 00 to 10 SET > Tone Control/TBW > TX > 
Send/read SSB TX Tone (Bass) level
(00=–5 to 10=+5)

0016 00 to 10 SET > Tone Control/TBW > TX > 
Send/read SSB TX Tone (Treble) level 
(00=–5 to 10=+5)

0017 See p. 16 SET > Tone Control/TBW > TX > 
Send/read SSB TX bandwidth for wide

0018 See p. 16 SET > Tone Control/TBW > TX > 
Send/read SSB TX bandwidth for mid

0019 See p. 16 SET > Tone Control/TBW > TX > 
Send/read SSB TX bandwidth for narrow

0020 See p. 16 SET > Tone Control/TBW > TX > 
SSB-D TX passband width

0021 00 to 10 SET > Tone Control/TBW > TX > 
Send/read AM TX Tone (Bass) level
(00=–5 to 10=+5)

0022 00 to 10 SET > Tone Control/TBW > TX > 
Send/read AM TX Tone (Treble) level 
(00=–5 to 10=+5)

0023 00 to 10 SET > Tone Control/TBW > TX > 
Send/read FM TX Tone (Bass) level
(00=–5 to 10=+5)

0024 00 to 10 SET > Tone Control/TBW > TX > 
Send/read FM TX Tone (Treble) level 
(00=–5 to 10=+5)

0025 00 to 10 SET > Tone Control/TBW > TX > 
Send/read DV TX Tone (Bass) level
(00=–5 to 10=+5)

0026 00 to 10 SET > Tone Control/TBW > TX > 
Send/read DV TX Tone (Treble) level
(00=–5 to 10=+5)
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Cmd. Sub cmd. Data Description
1A* 05 0027 0000 ~ 0255 SET > Function > Beep Level

(0000=Minimum to 0255=Maximum)
0028 00 or 01 SET > Function > Beep Level Limit

(00=OFF, 01=ON)
0029 00 or 01 SET > Function > Beep (Confirmation)

(00=OFF, 01=ON)
0030 00 or 01 SET > Function > Band Edge Beep

(00=OFF, 01=ON)
( ON = Beep sounds with a default amateur 
band)

02 SET > Function > Band Edge Beep
(02=ON (User))

03 SET > Function > Band Edge Beep
(03=ON (User) & TX Limit)

0031 0050 ~ 0200 SET > Function > Beep Sound (MAIN)
(0050=500 Hz to 0200=2000 Hz)

0032 0050 ~ 0200 SET > Function > Beep Sound (SUB)
(0050=500 Hz to 0200=2000 Hz)

0033 00 or 01 SET > Function > Sub Band Mute (TX) >  
Speaker/Phones
(00=OFF, 01=ON)

0034 00 or 01 SET > Function > Sub Band Mute (TX) > USB
(00=OFF, 01=ON)

0035 00 or 01 SET > Function > Sub Band Mute (TX) > LAN
(00=OFF, 01=ON)

0036 00 to 02 SET > Function > RF/SQL Control
(00=Auto, 01=SQL, 02=RF+SQL)

0037 00 or 01 SET > Function >  
FM/DV Center Error function
(00=OFF, 01=ON)

0038 00 to 05 SET > Function > TX Delay > 144M
(00=OFF, 01=10 ms, 02=15 ms, 
 03=20 ms, 04=25 ms, 05=30 ms)

0039 00 to 05 SET > Function > TX Delay > 430M
(00=OFF, 01=10 ms, 02=15 ms, 
 03=20 ms, 04=25 ms, 05=30 ms)

0040 00 to 05 SET > Function > TX Delay > 1200M
(00=OFF, 01=10 ms, 02=15 ms, 
 03=20 ms, 04=25 ms, 05=30 ms)

0041 00 to 05 SET > Function > Time-Out Timer
( 00=OFF, 01=3 min., 02=5 min., 03=10 min., 
04=20 min., 05=30 min.)

0042 00 or 01 SET > Function > PTT Lock
(00=OFF, 01=ON)

0043 00 or 01 SET > Function > SPLIT > Quick SPLIT
(00=OFF, 01=ON)
( Setting the [SPLIT] key operation when it is 
held down for 1 second.)

0044 See p. 16 SET > Function > SPLIT > FM SPLIT Offset

0045 00 or 01 SET > Function > SPLIT > SPLIT LOCK
(00=OFF, 01=ON)

0046 00 or 01 SET > Function > Auto Repeater
( 00=OFF, 
01=ON (DUP,TONE) for USA version)

0047 00 to 02 SET > Function > RTTY Mark Frequency
(00=1275 Hz, 01=1615 Hz, 02=2125 Hz)

0048 00 to 02 SET > Function > RTTY Shift Width
(00=170 Hz, 01=200 Hz, 02=425 Hz)

0049 00 or 01 SET > Function > RTTY Keying Polarity
(00=Normal, 01=Reverse)

0050 00 or 01 SET > Function > SPEECH >  
SPEECH Language
(00=English, 01=Japanese)

0051 00 or 01 SET > Function > SPEECH > Alphabet
(00=Normal, 01=Phonetic Code)

0052 00 or 01 SET > Function > SPEECH >  
SPEECH Speed
(00=Slow, 01=Fast)

0053 00 to 02 SET > Function > SPEECH >  
RX Call Sign SPEECH
(00=OFF, 01=ON (Kerchunk), 02=ON (All))

0054 00 or 01 SET > Function > SPEECH >  
RX>CS SPEECH
(00=OFF, 01=ON)

0055 00 or 01 SET > Function > SPEECH >  
S-Level SPEECH
(00=OFF, 01=ON)

 D Command table (Continued)
Cmd. Sub cmd. Data Description
1A* 05 0056 00 or 01 SET > Function > SPEECH >  

MODE SPEECH
(00=OFF, 01=ON)

0057 0000 ~ 0255 SET > Function > SPEECH > SPEECH Level
(0000=0% to 0255=100%)

0058 00 or 01 SET > Function > [SPEECH/LOCK] Switch
(00=SPEECH/LOCK, 01=LOCK/SPEECH)

0059 00 or 01 SET > Function > Lock Function
(00=MAIN DIAL, 01=PANEL)

0060 00 or 01 SET > Function > Memo Pad Quantity
(00=5 ch, 01=10 ch)

0061 00 to 02 SET > Function > MAIN DIAL Auto TS
(00=OFF, 01=Low, 02=High)

0062 00 or 01 SET > Function > MIC Up/Down Speed
(00=Slow, 01=Fast)

0063 00 or 01 SET > Function > AFC Limit
(00=OFF, 01=ON)

0064 00 to 02 SET > Function > [NOTCH] Switch (SSB)
(00=Auto, 01=Manual, 02=Auto/Manual)

0065 00 to 02 SET > Function > [NOTCH] Switch (AM)
(00=Auto, 01=Manual, 02=Auto/Manual)

0066 00 or 01 SET > Function >  
SSB/CW Synchronous Tuning
(00=OFF, 01=ON)

0067 00 or 01 SET > Function > CW Normal Side
(00=LSB, 01=USB)

0068 00 or 01 SET > Function > Screen Keyboard Type
(00=Ten-key, 01=Full Keyboard)

0069 00 to 02 SET > Function >  
Screen Full Keyboard Layout
(00=English, 01=German, 02=French)

0070 00 or 01 SET > Function >  
Screen Capture [POWER] Switch
(00=OFF, 01=ON)

0071 00 or 01 SET > Function > Screen Capture File Type
(00=PNG, 01=BMP)

0072 0000 ~ 0255 SET > Function > REF Adjust
(0000=0%, 0255=100%)

0073 0000 ~ 0255 SET > Function > REF Adjust (FINE)
(0000=0%, 0255=100%)

0074 00 to 03 SET > DV/DD Set > Standby Beep
( 00=OFF, 01=ON, 02=ON (to me: High Tone),  
03=ON (to me: Alarm/High Tone))

0075 00 to 02 SET > DV/DD Set > Auto Reply
(00=OFF, 01=ON, 02=Voice)

0076 00 or 01 SET > DV/DD Set > DV Data TX
( 00=PTT 01=Auto)

0077 00 or 01 SET > DV/DD Set > DV Fast Data > Fast Data
(00=OFF, 01=ON)

0078 00 or 01 SET > DV/DD Set > DV Fast Data >  
GPS Data Speed
(00=Slow, 01=Fast)

0079 00 to 10 SET > DV/DD Set > DV Fast Data >  
TX Delay (PTT)
(00=OFF, 01=1 sec. to 10=10 sec.)

0080 00 to 02 SET > DV/DD Set > Digital Monitor
(00=Auto, 01=Digital, 02=Analog)

0081 00 or 01 SET > DV/DD Set > Digital Repeater Set
(00=OFF, 01=ON)

0082 00 or 01 SET > DV/DD Set > DV Auto Detect
(00=OFF, 01=ON)

0083 00 or 01 SET > DV/DD Set > RX Record (RPT)
(00=ALL, 01=Latest Only)

0084 00 or 01 SET > DV/DD Set > BK
(00=OFF, 01=ON)

0085 00 or 01 SET > DV/DD Set > EMR
(00=OFF, 01=ON)

0086 0000 ~ 0255 SET > DV/DD Set > EMR AF Level
(0000=0%, 0255=100%)

0087 00 or 01 SET > DV/DD Set >  
DD TX Inhibit (Power ON) 
(00=OFF, 01=ON)

0088 00 or 01 SET > DV/DD Set > DD Packet Output
(00=Normal, 01=All)

0089 00 or 01 SET > QSO/RX Log > QSO Log
(00=OFF, 01=ON)

Remote control

6



Cmd. Sub cmd. Data Description
1A* 05 0090 00 or 01 SET > QSO/RX Log > RX History Log

(00=OFF, 01=ON)
0091 00 to 02 SET > QSO/RX Log > CSV Format >  

Separator/Decimal
( 00=Separator is “ , ” and Decimal is “ . ,” 
01=Separator is “ ; ” and Decimal is “ . ,” 
02=Separator is “ ; ” and Decimal is “ , ”)

0092 00 to 02 SET > QSO/RX Log > CSV Format > Date
( 00=“yyyy/mm/dd,” 01=“mm/dd/yyyy,”  
02=“dd/mm/yyyy”)

0093 00 or 01 SET > Connectors > External P.AMP > 144M
(00=OFF, 01=ON)

0094 00 or 01 SET > Connectors > External P.AMP > 430M
(00=OFF, 01=ON)

0095 00 or 01 SET > Connectors > External P.AMP > 1200M
(00=OFF, 01=ON)

0096 00 or 01 SET > Connectors >  
External Speaker Separate
(00=Separate, 01=Mix)

0097 00 to 30 SET > Connectors > Phones > Level
(00=–15 dB to 30=+15 dB)

0098 00 to 02 SET > Connectors > Phones > L/R Mix
(00=Separate, 01=Mix, 02=Auto)

0099 00 or 01 SET > Connectors > ACC AF/IF Output > 
AF/SQL Output Select
(00=MAIN, 01=SUB)

0100 00 or 01 SET > Connectors > ACC AF/IF Output >  
Output Select
(00=AF, 01=IF)

0101 0000 ~ 0255 SET > Connectors > ACC AF/IF Output > 
AF Output Level
(0000=0% to 0255=100%)

0102 00 or 01 SET > Connectors > ACC AF/IF Output >  
AF SQL
(00=OFF (Open), 01=ON)

0103 00 or 01 SET > Connectors > ACC AF/IF Output >  
AF Beep/Speech... Output
(00=OFF, 01=ON)

0104 0000 ~ 0255 SET > Connectors > ACC AF/IF Output >  
ACC IF Output Level
(0000=0% to 0255=100%)

0105 00 or 01 SET > Connectors > USB AF/IF Output >  
Output Select
(00=AF, 01=IF)

0106 0000 ~ 0255 SET > Connectors > USB AF/IF Output >  
AF Output Level
(0000=0%, 0255=100%)

0107 00 or 01 SET > Connectors > USB AF/IF Output >  
AF SQL
(00=OFF (Open), 01=ON)

0108 00 or 01 SET > Connectors > USB AF/IF Output >  
AF Beep/Speech... Output
(00=OFF, 01=ON)

0109 0000 ~ 0255 SET > Connectors > USB AF/IF Output >  
IF Output Level
(0000=0%, 0255=100%)

0110 00 or 01 SET > Connectors > LAN AF/IF Output >  
Output Select
(00=AF, 01=IF)

0111 00 or 01 SET > Connectors > LAN AF/IF Output >  
AF SQL
(00=OFF (Open), 01=ON)

0112 0000 ~ 0255 SET > Connectors > MOD Input > ACC MOD 
Level
(0000=0% to 0255=100%)

0113 0000 ~ 0255 SET > Connectors > MOD Input > USB MOD 
Level
(0000=0% to 0255=100%)

0114 0000 ~ 0255 SET > Connectors > MOD Input > LAN MOD 
Level
(0000=0% to 0255=100%)

0115 00 ~ 05 SET > Connectors > MOD Input >  
DATA OFF MOD
( 00=MIC, 01=ACC, 02=MIC,ACC, 03=USB, 
04=MIC,USB, 05=LAN)

0116 00 ~ 05 SET > Connectors > MOD Input >  
DATA MOD
( 00=MIC, 01=ACC, 02=MIC,ACC, 03=USB, 
04=MIC,USB, 05=LAN)

Cmd. Sub cmd. Data Description
1A* 05 0117 00 or 01 SET > Connectors >  

ACC SEND Output > 144M
(00=OFF, 01=ON)

0118 00 or 01 SET > Connectors >  
ACC SEND Output > 430M
(00=OFF, 01=ON)

0119 00 or 01 SET > Connectors >  
ACC SEND Output > 1200M
(00=OFF, 01=ON)

0120 00 to 04 SET > Connectors > USB SEND/Keying >  
USB SEND
( 00=OFF, 01=USB(A) DTR, 02=USB(A) RTS, 
03=USB(B) DTR, 04=USB(B) RTS)

( You cannot select the same setting for USB 
keying (CW) or USB keying (RTTY).)

0121 00 to 04 SET > Connectors > USB SEND/Keying >  
USB Keying (CW)
( 00=OFF, 01=USB(A) DTR, 02=USB(A) RTS, 
03=USB(B) DTR, 04=USB(B) RTS)

( You cannot select the same setting for USB 
SEND.)

0122 00 to 04 SET > Connectors > USB SEND/Keying >  
USB Keying (RTTY)
( 00=OFF, 01=USB(A) DTR, 02=USB(A) RTS, 
03=USB(B) DTR, 04=USB(B) RTS)

( You cannot select the same setting for USB 
SEND.)

0123 00 or 01 SET > Connectors > USB SEND/Keying >  
Inhibit Timer at USB connection
(00=OFF, 01=ON)

0124 00 or 01 SET > Connectors > External Keypad >  
VOICE
(00=OFF, 01=ON)

0125 00 or 01 SET > Connectors > External Keypad >  
KEYER
(00=OFF, 01=ON)

0126 00 or 01 SET > Connectors > External Keypad >  
RTTY
(00=OFF, 01=ON)

0127 00 or 01 SET > Connectors > CI-V > CI-V Transceive
(00=OFF, 01=ON)

0128 0000 ~ 0223                      SET > Connectors > CI-V > CI-V USB/
LAN→REMOTE Transceive Address
(0000=00h to 0223=DFh in Hexadecimal)

0129
*1

00 or 01 SET > Connectors > CI-V > CI-V USB Port
( 00=Link to [REMOTE], 01=Unlink to [REMOTE])

0130 00 or 01 SET > Connectors > CI-V >  
CI-V USB Echo Back
(00=OFF, 01=ON)

0131 00 or 01 SET > Connectors > CI-V >  
CI-V DATA Echo Back
(00=OFF, 01=ON)

0132 00 to 02 SET > Connectors > CI-V >  
USB (B)/DATA Function > USB (B) Function
(00=OFF, 01=RTTY Decode, 02=DV Data)

0133 00 to 04 SET > Connectors > CI-V >  
USB (B)/DATA Function > DATA Function
( 00=OFF, 01=RTTY Decode, 02=DV Data, 
03= GPS/Weather, 04= CI-V)

0134 00 or 01 SET > Connectors > CI-V >  
USB (B)/DATA Function > GPS Out
(00=OFF, 01=DATA→USB (B))

0135 00 or 01 SET > Connectors > CI-V >  
USB (B)/DATA Function >  
DV Data/GPS Out Baud Rate
( 00=4800bps, 01=9600bps)

0136 00 to 03 SET > Connectors > CI-V >  
USB (B)/DATA Function >  
RTTY Decode Baud Rate
( 00=4800bps, 01=9600bps,  
02=19200bps, 03=38400bps)

0137 00 or 01 SET > Network > DHCP (Valid after Restart)
(00=OFF, 01=ON)

0138  0000000000 
000001 ~  
0255025502 
550254

SET > Network > IP Address (Valid after 
Restart)
( 0000000000000001=0.0.0.1 to 0255025502
550254=255.255.255.254)

( Valid when the DHCP (Valid after Restart) is 
set to OFF.)

 D Command table (Continued)
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Cmd. Sub cmd. Data Description
1A* 05 0139

*1
0000000000
000001 ~ 
0255025502
550254

SET > Network > DHCP (Valid after Restart)
Read the IP address set by the DHCP server
( 0000000000000001=0.0.0.1 to 0255025502
550254=255.255.255.254)

( When the DHCP setting (Valid after Restart) 
is set to OFF, the manually set IP address 
(static IP address) is returned.)

0140 01 ~ 30 SET > Network >  
Subnet Mask (Valid after Restart)
(01=128.0.0.0 (1 bit) to 30=255.255.255.252 
(30 bit))
( Valid when the DHCP (Valid after Restart) 
setting is set to OFF.)

0141 0000000000
000001 ~ 
0255025502
550254, FF

SET > Network >  
Default Gateway (Valid after Restart)
( 0000000000000001=0.0.0.1 to 0255025502
550254=255.255.255.254, FF=Blank)

( Valid when the DHCP (Valid after Restart) 
setting is set to OFF.)

0142 0000000000
000001 ~ 
0255025502
550254, FF

SET > Network >  
Primary DNS Server (Valid after Restart)
( 0000000000000001=0.0.0.1 to 0255025502
550254=255.255.255.254, FF=Blank)

( Valid when the DHCP (Valid after Restart) 
setting is set to OFF.)

0143 0000000000
000001 ~ 
0255025502
550254, FF

SET > Network >  
2nd DNS Server (Valid after Restart)
( 0000000000000001=0.0.0.1 to 0255025502
550254=255.255.255.254, FF=Blank)

( Valid when the DHCP (Valid after Restart) 
setting is set to OFF.)

0144 See p. 15 SET > Network > Network Name
(Up to 15 characters)

0145 00 or 01 SET > Network >  
Network Control (Valid after Restart)
(00=OFF, 01=ON)

0146 00 or 01 SET > Network >  
Power OFF Setting (for Remote Control)
(00=Shutdown only, 01=Standby/Shutdown)

0147 000001 ~  
065535

SET > Network >  
Control Port (UDP) (Valid after Restart)
(000001=1 to 065535=65535)

0148 000001 ~  
065535

SET > Network >  
Serial Port (UDP) (Valid after Restart)
(000001=1 to 065535=65535)

0149 000001 ~  
065535

SET > Network >  
Audio Port (UDP) (Valid after Restart)
(000001=1 to 065535=65535)

0150 00 or 01 SET > Network >  
Internet Access Line (Valid after Restart)
( 00=FTTH (Fiber To The Home), 01=ADSL/
CATV)

0151 See p. 15 SET > Network > Network Radio Name
(Up to 16 characters)

0152 0000 ~ 0255 SET > Display > LCD Backlight
(0000=0% to 0255=100%)

0153 00 or 01 SET > Display > Display Type
(00=A, 01=B)

0154 00 or 01 SET > Display > Display Font
(00=Basic, 01=Round)

0155 00 or 01 SET > Display > Meter Peak Hold (Bar)
(00=OFF, 01=ON)

0156 00 or 01 SET > Display > Memory Name
(00=OFF, 01=ON)

0157 00 or 01 SET > Display >  
MN-Q Popup (MN OFF→ON)
(00=OFF, 01=ON)

0158 00 or 01 SET > Display > BW Popup (PBT)
(00=OFF, 01=ON)

0159 00 or 01 SET > Display > BW Popup (FIL)
(00=OFF, 01=ON)

0160 00 to 03 SET > Display > RX Call Sign Display
(00=OFF, 01=Normal, 02=RX Hold, 03=Hold)

0161 00 or 01 SET > Display > RX Position Indicator
(00=OFF, 01=ON)

0162 00 to 02 SET > Display > RX Position Display
( 00=OFF, 01=ON (Main/Sub),  
02=ON (Main Only))

Cmd. Sub cmd. Data Description
1A* 05 0163 00 to 04 SET > Display > RX Position Display Timer

( 00=5 sec, 01=10 sec, 02=15 sec,  
03=30 sec, 04=Hold)

0164 00 or 01 SET > Display > Reply Position Display
(00=OFF, 01=ON)

0165 00 to 02 SET > Display > TX Call Sign Display
( 00=OFF, 01=Your Call Sign,  
02=My Call Sign)

0166 00 or 01 SET > Display > Scroll Speed
(00=Slow, 01=Fast)

0167 00 to 03 SET > Display > Screen Saver
( 00=OFF, 01=15 min.,  
02=30 min., 03=60 min.)

0168 00 or 01 SET > Display > Opening Message
(00=OFF, 01=ON)

0169 00 or 01 SET > Display > Power ON Check
(00=OFF, 01=ON)

0170 00 to 02 SET > Display > Display Unit > 
Latitude/Longitude
( 00=ddd°mm.mm', 01=ddd°mm'ss",  
02=ddd.dddd°)

0171 00 or 01 SET > Display > Display Unit > 
Altitude/Distance
(00=m, 01=ft/mi)

0172 00 to 02 SET > Display > Display Unit > Speed
(00=km/h, 01=mph, 02=knots)

0173 00 or 01 SET > Display > Display Unit > Temperature
(00=ºC, 01=ºF)

0174 00 to 03 SET > Display > Display Unit > Barometric
(00=hPa, 01=mb, 02=mmHg, 03=inHg)

0175 00 or 01 SET > Display > Display Unit > Rainfall
(00=mm, 01=inch)

0176 00 to 03 SET > Display > Display Unit > Wind Speed
(00=m/s, 01=km/h, 02=mph, 03=knots)

0177 00 or 01 SET > Display > Display Language
(00=English, 01=Japanese)

0178 00 or 01 SET > Display > System Language
(00=English, 01=Japanese)

0179 20000101 ~  
20991231

SET > Time Set > Date/Time > Date
(20000101=2000/01/01 to 20991231=2099/12/31)

0180 0000 ~ 2359 SET > Time Set > Date/Time > Time
(0000=00:00 to 2359=23:59)

0181 00 or 01 SET > Time Set > Date/Time > NTP Function
(00=OFF, 01=ON)

0182 See p. 15 SET > Time Set > Date/Time >  
NTP Server Address

0183 00 or 01 SET > Time Set > Date/Time >  
GPS Time Correct
(00=OFF, 01=Auto)

0184 See p. 16 SET > Time Set > UTC Offset
0185 00 to 02 SET > SD Card > Import/Export >  

CSV Format > Separator/Decimal
( 00=Separator is “ , ” and Decimal is “ . ,” 
01=Separator is “ ; ” and Decimal is “ . ,” 
02=Separator is “ ; ” and Decimal is “ , ”)

0186 00 to 02 SET > SD Card > Import/Export >  
CSV Format > Date
( 00=““yyyy/mm/dd,” 01=“mm/dd/yyyy,”  
02=“dd/mm/yyyy”)

0187 00 or 01 SCOPE > Scope during Tx (CENTER TYPE)
(00=OFF, 01=ON)

0188 00 to 02 SCOPE > Max Hold
(00=OFF, 01=10s Hold, 02=ON)

0189 00 ~ 02 SCOPE > CENTER Type Display
( 00=Filter center, 01=Carrier point center, 
02=Carrier point center (Abs. Freq.))

0190 00 or 01 SCOPE > Marker Position (Fix Type/SCROLL 
Type)
(00=Filter center, 01 Carrier point)

0191 See p. 16 SCOPE > VBW
0192 00 to 03 SCOPE > Averaging

(00=OFF, 01=2, 02=3, 03=4)
0193 00 or 01 SCOPE > Waveform Type

(00=Fill, 01=Fill+Line)
0194 See p. 16 SCOPE > Waveform Color (Current)
0195 See p. 16 SCOPE > Waveform Color (Line)
0196 See p. 16 SCOPE > Waveform Color (Max Hold)
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Cmd. Sub cmd. Data Description
1A* 05 0197 00 or 01 SCOPE > Waterfall Display

(00=OFF, 01=ON)
0198 00 to 02 SCOPE > Waterfall Speed

(00=Slow, 01=Mid, 02=Fast)
0199 00 to 02 SCOPE > Waterfall Size (Expand Screen)

(00=Small, 01=Mid, 02=Large)
0200 00 to 07 SCOPE > Waterfall Peak Color Level

(00=Grid 1 to 07=Grid 8)
0201 00 or 01 SCOPE > Waterfall Marker Auto-hide

(00=OFF, 01=ON)
0202 See p. 17 SCOPE > Fixed Edges > 144M > No.1:
0203 See p. 17 SCOPE > Fixed Edges > 144M > No.2:
0204 See p. 17 SCOPE > Fixed Edges > 144M > No.3:
0205 See p. 17 SCOPE > Fixed Edges > 430M > No.1:
0206 See p. 17 SCOPE > Fixed Edges > 430M > No.2:
0207 See p. 17 SCOPE > Fixed Edges > 430M > No.3:
0208 See p. 17 SCOPE > Fixed Edges > 1200M > No.1:
0209 See p. 17 SCOPE > Fixed Edges > 1200M > No.2:
0210 See p. 17 SCOPE > Fixed Edges > 1200M > No.3:
0211 00 or 01 AUDIO SCOPE SET >  

FFT Scope Waveform Type
(00=Line, 01=Fill)

0212 See p. 16 AUDIO SCOPE SET > 
FFT Scope Waveform Color

0213 00 or 01 AUDIO SCOPE SET > 
FFT Scope Waterfall Display
(00=OFF, 01=ON)

0214 See p. 16 AUDIO SCOPE SET > 
Oscilloscope Waveform Color

0215 0000 ~ 0255 VOICE TX > TX LEVEL
(0000=0%, 0255=100%)

0216 00 or 01 VOICE TX SET > Auto Monitor
(00=OFF, 01=ON)

0217 01 to 15 VOICE TX SET > Repeat Time
(01=1 sec. to 15=15 sec.)

0218 00 to 04 KEYER 001 > Number Style
( 00=Normal, 01=190→ANO, 02=190→ANT, 
03=90→NO, 04=90→NT)

0219 01 to 08 KEYER 001 > Count Up Trigger
(01=M1 to 08=M8)

0220 0001 to 9999 KEYER 001 > Present Number
(0001=1 to 9999=9999)

0221 0000 ~ 0255 CW-KEY SET > Side Tone Level
(0000=0% to 0255=100%)

0222 00 or 01 CW-KEY SET > Side Tone Level Limit
(00=OFF, 01=ON)

0223 01 to 60 CW-KEY SET > Keyer Repeat time
(01=1 sec. to 60=60 sec.)

0224 28 to 45 CW-KEY SET > Dot/Dash Ratio
(28=1:1:2.8 to 45=1:1:4.5; 0.1 steps)

0225 00 to 03 CW-KEY SET > Rise Time
(00=2 msec., 01=4 msec., 02=6 msec., 
 03=8 msec.)

0226 00 or 01 CW-KEY SET > Paddle Polarity
(00=Normal, 01=Reverse)

0227 00 to 02 CW-KEY SET > Key Type
(00=Straight, 01=Bug, 02=Paddle)

0228 00 or 01 CW-KEY SET > MIC Up/Down Keyer
(00=OFF, 01=ON)

0229 00 to 03 RTTY DECODE SET > FFT Scope Averaging
(00=OFF, 01=2, 02=3, 03=4)

0230 See p. 16 RTTY DECODE SET > 
FFT Scope Waveform Color

0231 00 or 01 RTTY DECODE SET > Decode USOS
(00=OFF, 01=ON)

0232 00 or 01 RTTY DECODE SET > Decode New Line Code
(00=CR, LF, CR+LF, 01=CR+LF)

0233 00 or 01 RTTY DECODE SET > TX USOS
(00=OFF, 01=ON)

0234 00 or 01 RTTY DECODE SET >  
Displayed Characters during Tx (Satellite)
( 00=Displayed Characters during RX,  
01=Displayed Characters during TX)

0235 See p. 16 RTTY DECODE SET > Font Color (Receive)
0236 See p. 16 RTTY DECODE SET > Font Color (Transmit) 
0237 00 or 01 RTTY DECODE LOG > Decode Log

(00=OFF, 01=ON)

 D Command table (Continued)
Cmd. Sub cmd. Data Description

0238 00 or 01 RTTY DECODE LOG > Log Set > File Type
(00=Text, 01=HTML)

1A* 05 0239 00 or 01 RTTY DECODE SET > Log Set >  
Time Stamp
(00=OFF, 01=ON)

0240 00 or 01 RTTY DECODE SET > Log Set >  
Time Stamp (Time)
(00=Local, 01=UTC)

0241 00 or 01 RTTY DECODE SET > Log Set >  
Time Stamp (Frequency)
(00=OFF, 01=ON)

0242 00 or 01 QSO RECORDER > Recorder Set >  
TX REC Audio
(00=Direct, 01=Monitor)

0243 00 or 01 QSO RECORDER > Recorder Set >  
RX REC Condition
(00=Always, 01=Squelch Auto)

0244 00 or 01 QSO RECORDER > Recorder Set >  
File Split
(00=OFF, 01=ON)

0245 00 or 01 QSO RECORDER > Recorder Set >  
REC Operation 
( 00=MAIN/SUB Separate,  
01=MAIN/SUB Link)

0246 00 or 01 QSO RECORDER > Recorder Set >  
PTT Auto REC
(00=OFF, 01=ON)

0247 00 to 03 QSO RECORDER > Recorder Set >  
PRE-REC for PTT Auto REC
(00=OFF, 01=5 sec., 02=10 sec., 03=15 sec.)

0248 00 to 03 QSO RECORDER > Player Set > Skip Time
(00=3 sec., 01=5 sec., 02=10 sec., 03=30 sec.)

0249 00 or 01 SCAN SET > SCAN Speed
(00=Slow, 01=Fast)

0250 00 or 01 SCAN SET > SCAN Resume
(00=OFF, 01=ON)

0251 00 to 10 SCAN SET > Pause Timer
( 00=2 sec. to 09=20 sec.; 2 sec. steps,  
10=HOLD)

0252 00 to 06 SCAN SET > Resume Timer 
(00=0 sec. to 05=5 sec., 06=HOLD)

0253 00 to 04 SCAN SET > Temporary Skip Timer 
( 00=5 min., 01=10 min., 02=15 min.,  
03=While Scanning, 04=While Powered ON)

0254 00 or 01 SCAN SET > MAIN DIAL Operation (SCAN)
(00=OFF, 01=Up/Down)

0255 00 to 02 GPS > GPS Set > GPS Select
(00=OFF, 01=External GPS, 02=Manual)

0256 00 or 01 GPS > GPS Set > GPS Receiver Baud Rate
( 00=4800bps, 01=9600bps)

0257 See p. 17 GPS > GPS Set > Manual Position
0258 00 to 02 GPS > GPS TX Mode

(00=OFF, 01=D-PRS, 02=NMEA)
0259 See p. 17 GPS > GPS TX Mode > D-PRS >  

Unproto Address (Up to 56 characters)
0260 00 to 03 GPS > GPS TX Mode > D-PRS > TX Format

( 00=Position, 01=Object,  
02=Item, 03=Weather)

0261 00 to 04 GPS > GPS TX Mode > D-PRS > TX Format > 
Position > Symbol
(00=No.1, 01=No.2, 02=No.3, 03=No.4)

0262 See p. 17 GPS > GPS TX Mode > D-PRS >  
TX Format > Position >  
the GPS-A Symbol No.1 setting (2 characters)

0263 See p. 17 GPS > GPS TX Mode > D-PRS >  
TX Format > Position >  
the GPS-A Symbol No.2 setting (2 characters)

0264 See p. 17 GPS > GPS TX Mode > D-PRS >  
TX Format > Position >  
the GPS-A Symbol No.3 setting (2 characters)

0265 See p. 17 GPS > GPS TX Mode > D-PRS >  
TX Format > Position >  
the GPS-A Symbol No.4 setting (2 characters)

0266 00 to 42 GPS > GPS TX Mode > D-PRS > TX Format > 
Position > SSID
( 00=---, 01=(-0), 02=-1 to 16=-15,  
17=-A to 42=-Z)
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 D Command table (Continued)
Cmd. Sub cmd. Data Description

0267 00 to 03 GPS > GPS TX Mode > D-PRS > TX Format > 
Position > Comment
( 00=1 to 03=4)

1A* 05 0268 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Position > Comment 1 (Up to 43 characters)

0269 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Position > Comment 2 (Up to 43 characters)

0270 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Position > Comment 3 (Up to 43 characters)

0271 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Position >  Comment 4 (Up to 43 characters)

0272 00 to 02 GPS > GPS TX Mode > D-PRS > TX Format >  
Position > Time Stamp
(00=OFF, 01=DHM, 02=HMS)

0273 00 or 01 GPS > GPS TX Mode > D-PRS > TX Format >  
Position > Altitude
(00=OFF, 01=ON)

0274 00 to 02 GPS > GPS TX Mode > D-PRS > TX Format >  
Position > Data Extension
( 00=OFF, 01=Course/Speed,  
02=Power/Height/Gain/Directivity)

0275 00 to 09 GPS > GPS TX Mode > D-PRS > TX Format >  
Position > Power
( 00=0W, 01=1W, 02=4W, 03=9W,  
04=16W, 05=25W, 06=36W, 07=49W,  
08=64W, 09=81W)

0276 00 to 09 GPS > GPS TX Mode > D-PRS > TX Format >  
Position > Height
( 00=3 m (10 ft), 01=6 m (20 ft),  
02=12 m (40 ft), 03=24 m (80 ft),  
04=49 m (160 ft), 05=98 m (320 ft),  
06=195 m (640 ft), 07=390 m (1280 ft),  
08=780 m (2560 ft), 09=1561 m (5120 ft))

0277 00 to 09 GPS > GPS TX Mode > D-PRS > TX Format >  
Position > Gain
(00=0 dB to 09=9 dB)

0278 00 to 08 GPS > GPS TX Mode > D-PRS > TX Format >  
Position > Directivity
( 00=Omni, 01=45ºNE, 02=90ºE, 03=135ºSE,  
04=180ºS, 05=225ºSW, 06=270ºW,  
07=315ºNW, 08=360ºN)

0279 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Object > Object Name (Up to 9 characters)

0280 00 or 01 GPS > GPS TX Mode > D-PRS > TX Format >  
Object > Data Type
(00=Live Object, 01=Kill Object)

0281 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Object > Symbol (2 characters)

0282 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Object > Comment (Up to 43 characters)

0283 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Object > Position

0284 00 to 02 GPS > GPS TX Mode > D-PRS > TX Format >  
Object > Data Extension
( 00=OFF, 01=Course/Speed,  
02=Power/Height/Gain/Directivity)

0285 000 to 360 GPS > GPS TX Mode > D-PRS > TX Format >  
Object > Course (0º to 360º; 1 degree steps)

0286 00 to 1850 GPS > GPS TX Mode > D-PRS > TX Format >  
Object > Speed (0 km/h to 1850 km/h)

0287 00 to 09 GPS > GPS TX Mode > D-PRS > TX Format >  
Object > Power
( 00=0W, 01=1W, 02=4W, 03=9W,  
04=16W, 05=25W, 06=36W, 07=49W,  
08=64W, 09=81W)

0288 00 to 09 GPS > GPS TX Mode > D-PRS > TX Format >  
Object > Height
( 00=3 m (10 ft), 01=6 m (20 ft),  
02=12 m (40 ft), 03=24 m (80 ft),  
04=49 m (160 ft), 05=98 m (320 ft),  
06=195 m (640 ft), 07=390 m (1280 ft),  
08=780 m (2560 ft), 09=1561 m (5120 ft))

0289 00 to 09 GPS > GPS TX Mode > D-PRS > TX Format >  
Object > Gain
(00=0 dB to 09=9 dB)

0290 00 to 08 GPS > GPS TX Mode > D-PRS > TX Format >  
Object > Directivity
( 00=Omni, 01=45ºNE, 02=90ºE, 03=135ºSE,  
04=180ºS, 05=225ºSW, 06=270ºW,  
07=315ºNW, 08=360ºN)

Cmd. Sub cmd. Data Description
1A* 05 0291 00 to 42 GPS > GPS TX Mode > D-PRS > TX Format > 

Object > SSID
( 00=---, 01=(-0), 02=-1 to 16=-15,  
17=-A to 42=-Z)

0292 00 or 01 GPS > GPS TX Mode > D-PRS > TX Format >  
Object > Time Stamp
(00=DHM, 01=HMS)

0293 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Item > Item Name (Up to 9 characters)

0294 00 or 01 GPS > GPS TX Mode > D-PRS > TX Format >  
Item > Data Type
(00=Live Item, 01=Killed Item)

0295 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Item > Symbol (2 characters)

0296 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Item > Comment (Up to 43 characters)

0297 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Item > Position

0298 00 to 02 GPS > GPS TX Mode > D-PRS > TX Format >  
Item > Data Extension
( 00=OFF, 01=Course/Speed,  
02=Power/Height/Gain/Directivity)

0299 000 to 360 GPS > GPS TX Mode > D-PRS > TX Format >  
Item > Course (0º to 360º; 1 degree steps)

0300 00 to 1850 GPS > GPS TX Mode > D-PRS > TX Format >  
Item > Speed (0 km/h to 1850 km/h)

0301 00 to 09 GPS > GPS TX Mode > D-PRS > TX Format >  
Item > Power
( 00=0W, 01=1W, 02=4W, 03=9W,  
04=16W, 05=25W, 06=36W, 07=49W,  
08=64W, 09=81W)

0302 00 to 09 GPS > GPS TX Mode > D-PRS > TX Format >  
Item > Height
( 00=3 m (10 ft), 01=6 m (20 ft),  
02=12 m (40 ft), 03=24 m (80 ft),  
04=49 m (160 ft), 05=98 m (320 ft),  
06=195 m (640 ft), 07=390 m (1280 ft),  
08=780 m (2560 ft), 09=1561 m (5120 ft))

0303 00 to 09 GPS > GPS TX Mode > D-PRS > TX Format >  
Item > Gain
(00=0 dB to 09=9 dB)

0304 00 to 08 GPS > GPS TX Mode > D-PRS > TX Format >  
Item > Directivity
( 00=Omni, 01=45ºNE, 02=90ºE, 03=135ºSE,  
04=180ºS, 05=225ºSW, 06=270ºW,  
07=315ºNW, 08=360ºN)

0305 00 to 42 GPS > GPS TX Mode > D-PRS > TX Format >  
Item > SSID
( 00=---, 01=(-0), 02=-1 to 16=-15,  
17=-A to 42=-Z)

0306 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Weather > Symbol (2 characters)

0307 00 to 42 GPS > GPS TX Mode > D-PRS > TX Format >  
Weather > SSID
( 00=---, 01=(-0), 02=-1 to 16=-15,  
17=-A to 42=-Z)

0308 See p. 17 GPS > GPS TX Mode > D-PRS > TX Format >  
Weather > Comment (Up to 43 characters)

0309 00 to 02 GPS > GPS TX Mode > D-PRS > TX Format >  
Weather > Time Stamp
(00=OFF, 01=DHM, 02=HMS)

0310
*6

00 or 01 GPS > GPS TX Mode > NMEA >  
GPS Sentence (RMC)
(00=OFF, 01=ON)

0311
*6

00 or 01 GPS > GPS TX Mode > NMEA >  
GPS Sentence (CGA)
(00=OFF, 01=ON)

0312
*6

00 or 01 GPS > GPS TX Mode > NMEA >  
GPS Sentence (GLL)
(00=OFF, 01=ON)

0313
*6

00 or 01 GPS > GPS TX Mode > NMEA >  
GPS Sentence (GSA)
(00=OFF, 01=ON)

0314
*6

00 or 01 GPS > GPS TX Mode > NMEA >  
GPS Sentence (VTG)
(00=OFF, 01=ON)

0315
*6

00 or 01 GPS > GPS TX Mode > NMEA >  
GPS Sentence (GSV)
(00=OFF, 01=ON)
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 D Command table (Continued)
Cmd. Sub cmd. Data Description
1A* 05 0316 See p. 17 GPS > GPS TX Mode > NMEA >  

GPS Message (Up to 20 characters)
0317 See p. 17 GPS > GPS Alarm> Alarm Area (Group)
0318 00 to 03 GPS > GPS Alarm> Alarm Area (RX/Memory)

(00=Limited, 01=Extended, 02=Both)
0319 00 to 08 GPS > GPS Auto TX

( 00=OFF, 01**=5 sec., 02=10 sec., 03=30 
sec., 04=1 min., 05=3 min., 06=5 min., 
07=10 min., 08=30 min.)

** When 4 kinds of GPS sentences are 
selected, you cannot select “01.”

0320 00 to 03 DTMF SET > DTMF Speed
( 00=100ms, 01=200ms, 02=300ms,  
03=500 ms)

0321 0000 to 0255 Set the NB LEVEL (144 MHz)
(0000=0% to 0255=100%)

0322 00 to 09 Set the NB DEPTH (144 MHz)
(00=1 to 09=10)

0323 0000 to 0255 Set the NB WIDTH (144 MHz)
(0000=1 to 0255=100)

0324 0000 to 0255 Set the NB LEVEL (430 MHz)
(0000=0% to 0255=100%)

0325 00 to 09 Set the NB DEPTH (430 MHz)
(00=1 to 09=10)

0326 0000 to 0255 Set the NB WIDTH (430 MHz)
(0000=1 to 0255=100)

0327 0000 to 0255 Set the NB LEVEL (1200 MHz)
(0000=0% to 0255=100%)

0328 00 to 09 Set the NB DEPTH (1200 MHz)
(00=1 to 09=10)

0329 0000 to 0255 Set the NB WIDTH (1200 MHz)
(0000=1 to 0255=100)

0330 00 to 20 Set the VOX DELAY
(00=0.0 sec. to 20=2.0 sec.; 0.1 sec steps)

0331 00 to 03 Set the VOX voice delay
(00=OFF, 01=Short, 02=Mid, 03=Long)

0332 00 or 01 Set the TX PWR LIMIT (144M) function
(00=OFF, 01=ON)

0333 0000 to 0255 Set the TX PWR LIMIT (144M)
(0000=1 to 0255=100)

0334 00 or 01 Set the TX PWR LIMIT (430M) function
(00=OFF, 01=ON)

0335 0000 to 0255 Set the TX PWR LIMIT (430M)
(0000=1 to 0255=100)

0336 00 or 01 Set the TX PWR LIMIT (1200M) function
(00=OFF, 01=ON)

0337 0000 to 0255 Set the TX PWR LIMIT (1200M)
(0000=1 to 0255=100)

0338 00 or 01 Set the Received Call sign Display (“Name” 
or “Call Sign”)
(00=Call Sign, 01=Name)

0339 00 to 02 Set the Compass Direction
( 00=Heading Up, 01=North Up,  
02=South Up)

0340 00 or 01 SET > Function > Home CH Beep
(00=OFF, 01=ON)

0341 00 or 01 SET > Connectors > PTT Port Function
( 00=PTT Input,   
01=PTT Input + SEND Output)

0342 00 or 01 SET > Display > RX Picture Indicator
(00=OFF, 01=ON)

0343 See p. 17 SET > Function > Front Key
Customize > [VOX/BK-IN]

0344 See p. 18 SET > Function > Front Key
Customize > [AUTOTUNE/AFC]

0345 See p. 18 SET > Function > Front Key
Customize > [TONE/RX>CS]

0346 See p. 18 SET > Function > MIC Key Customize > [UP]
0347 See p. 18 SET > Function > MIC Key Customize > [DN]

0348 See p. 17 SCOPE > Fixed Edges > 144M > No.4
0349 See p. 17 SCOPE > Fixed Edges > 430M > No.4
0350 See p. 17 SCOPE > Fixed Edges > 1200M > No.4

06 See p. 18 DATA mode with filter set
07 See p. 19 Set the Satellite memory contents
08 00 or 01 NTP server access

(00=Terminate, 01=Initiate)

Cmd. Sub cmd. Data Description
1A* 09*1 00 to 02 Read NTP server access result

(00= Accessing, or have not accessed  
after Power ON, 

 01=Succeeded, 02=Failed)
0A*1 00 or 01 Read the OVF indicator status

(00=OFF, 01=ON)
0B 00 to 02 Picture TX (PICT TX)

(00=OFF, 01=ON, 02=Repeat ON)
( Returns ON even if the setting is OFF during 
batch transmission of images.)

1B* 00 See p. 20 Send/read the Repeater tone frequency
01 See p. 20 Send/read the TSQL tone frequency
02 See p. 20 Send/read the DTCS code and polarity
07 See p. 20 Send/read the CSQL code (DV mode)

1C 00* 00 or 01 Send/read the transceiver’s status
(00=RX, 01=TX)

02* 00 or 01 Send/read the Transmit frequency monitor 
(XFC)
(00=OFF, 01=ON)

03*1 See p. 13 Read the transmit frequency
1E 00*1 Read number of available TX frequency band

01*1 See p. 13 Read TX band edge frequencies
02*1 Read number of user-set TX frequency band
03* See p. 13 Set the user-set TX band edge frequencies

1F* 00 See p. 20 SET > My Station > My Call Sign (DV)
01 See p. 20 SET > Display > TX Call Sign Display
02 See p. 20 SET > My Station > TX Message (DV)

20 00 00* 00 or 01*7 Send/read the Auto DV RX Call signs output
(00=OFF, 01=ON)

01 See p. 21 Output DV RX Call signs for transceive
02*1 See p. 21 Read Auto DV RX Call signs

01 00* 00 or 01*7 Send/read the Auto DV RX message output
(00=OFF, 01=ON)

01 See p. 21 Output DV RX message for transceive
02*1 See p. 21 Read Auto DV RX message

02 00* 00 or 01*7 Send/read the Auto DV RX status output
(00=OFF, 01=ON)

01 See p. 21 Output DV RX status for transceive
02*1 See p. 21 Read Auto DV RX status

03 00* 00 or 01*7 Send/read the Auto DV RX GPS/D-PRS data 
output
(00=OFF, 01=ON)

0100 See p. 22 Output DV RX GPS/D-PRS Position for 
transceive

0101 See p. 22 Output DV RX D-PRS Object status for 
transceive

0102 See p. 22 Output DV RX D-PRS Item status for 
transceive

0103 See p. 22 Output DV RX D-PRS Weather  status for 
transceive

0200*1 See p. 22 Read Auto DV RX GPS/D-PRS Position status
0201*1 See p. 22 Read Auto DV RX D-PRS Object status
0202*1 See p. 22 Read Auto DV RX D-PRS Item status
0203*1 See p. 22 Read Auto DV RX D-PRS Weather status

04 00* 00 or 01*7 Send/read Auto DV RX  
GPS/D-PRS message output
(00=OFF, 01=ON)

01 See p. 23 Output DV RX D-PRS message for transceive
02*1 See p. 23 Read Auto DV RX D-PRS message status

21* 00 See p. 24 RIT frequency
01 00 or 01 RIT setting 

(00=OFF, 01=ON)
22 00 See p. 24 Set the DV TX data (Up to 30 byte)

01 00* 00 or 01 Set the Auto DV RX data output
01 See p. 24 Set the DV RX data for transceive  

(Up to 30 byte)
02* 00 or 01 SET > DV/DD Set > DV Data TX 

(00=PTT, 01=Auto)
03* 00 or 01 SET > DV/DD Set > DV Fast Data > Fast Data 

(00=OFF, 01=ON)
04* 00 or 01 SET > DV/DD Set > DV Fast Data >  

GPS Data Speed
(00=Slow, 01=Fast)

05* 00 to 10 SET > DV/DD Set > DV Fast Data >  
TX Delay (PTT)
(00=OFF, 01=1 sec. to 10=10 sec.)
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*(Asterisk) Send/read data
*1  Read only data
*2 Send only data
*3  In the CW mode, if the [TRANSMIT] or an external TX 

switch is ON, or the Break-in function is ON, a message 
will be transmitted as CW code when you send it from your 
PC.

*4  When sending the power ON command (18 01), you need 
to repeatedly send “FE” before the standard format. The 
following is the approximate number of needed repetitions.

 • 115200 bps: 119 “FE”s
 • 57600 bps: 59 “FE”s
 • 38400 bps: 40 “FE”s
 • 19200 bps: 20 “FE”s
 • 9600 bps: 9 “FE”s
 • 4800 bps: 5 “FE”s
  

×5

Example: When using 4800 bps

F 2AEFEF E E 10810 DF

Preamble 9700’s
address

Controller’s
address

Command Sub
command

Post
amble

*5  To insert a counter, first clear the other channel’s counter.
*6   Set at least 1 GPS sentence to ON.  

Up to 4 GPS sentences can be set to ON at the same time.
*7  Output setting is automatically set to OFF after turning 

OFF the transceiver.
*8   When you use the [USB] port, select “Unlink from 

[REMOTE]” in the “CI-V USB port” item, and select 
“115200” in the “CI-V Baud Rate” item.

 MENU  » SET > Connectors > CI-V
 You can use the [LAN] port, regardless of those settings.
  You cannot use the [REMOTE] terminal, regardless of 

those settings.

Cmd. Sub cmd. Data Description
23 00*1 See p. 24 Read the position status

01* 00, 02, 03 GPS > GPS Set > GPS Select
(00=OFF, 02=External GPS, 03=Manual)

02* See p. 17 GPS > GPS Set > Manual Position
24 00 00* 00 or 01 Send/read TX output power setting

(00=OFF, 01=ON)
01 00 or 01 Set the TX output power for transceive

(00=OFF, 01=ON)
25* See p. 24 Set the selected or unselected VFO frequency 

(Only MAIN band)
26* See p. 24 Set the selected or unselected VFO’s 

operating mode and filter (Only MAIN band)
27 00 See p. 25 Read the Scope waveform data

( Only when “Scope ON/OFF status” 
(Command: 27 10) and “Scope data output” 
(Command: 27 11) are set to “ON,” outputs 
the waveform data to the controller.)

10* 00 or 01 Send/read the Scope ON/OFF status
(00=OFF, 01=ON)

11*, *8 00 or 01 Send/read the Scope wave data output
(00=OFF, 01=ON)

12* 00 or 01 Send/read the Main or Sub scope setting
(00=Main, 01=Sub)

14* See p. 25 Send/read the Scope Center mode, Fixed 
mode, SCROLL-C mode, or SCROLL-F 
mode scope

15* See p. 25 Send/read the Span setting in the Center 
mode or SCROLL-C mode Scope

16* See p. 25 Send/read the Edge number setting in the 
Fixed mode or SCROLL-F mode Scope

17* See p. 25 Send/read the Scope hold function ON/OFF 
status

19* See p. 25 Send/read the Scope Reference level setting

1A* See p. 26 Send/read the Sweep speed setting
1B* 00 or 01 SCOPE > Scope during Tx (CENTER TYPE)

(00=OFF, 01=ON)
1C* 00 to 02 SCOPE > CENTER Type Display

(00=Filter center, 01=Carrier point center,
 02=Carrier point center (Abs. Freq.))

1D* See p. 16 Send/read the Scope VBW setting

1E* See p. 26 Send/read the Scope Fixed edge frequencies

20 00 or 01 Send/read the Marker Position (FIX Type/
SCROLL Type) setting
(00=Filter Center, 01=Carrier Point)

28 00 00 to 08 Voice TX Memory
(00=Stop, 01=T1 to 08=T8)

 D Command table (Continued)
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 DCommand formats
 • Operating frequency

Command: 00, 03, 05, 1C 03
1

XX X X X
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XX XX
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 • Operating mode
Command: 01, 04, 06

q w

XX X X

qOperating mode wFilter setting
00:LSB 05 :FM 01:FIL1
01:USB 07 :CW-R 02:FIL2
02:AM 08 :RTTY-R 03:FIL3
03:CW 17 :DV —
04:RTTY 22 :DD* —

*  22 Command (DD) can be selected when setting the 
1200 MHz band to other than the satellite mode.
L Filter setting, (w) can be skipped with command 01 

and 06. In that case, “FIL1” is selected with command 
01 and the default filter setting of the operating mode is 
automatically selected with command 06.

 • Duplex Offset frequency setting
Command: 0C, 0D

X X X

q w
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LOnly the 1200 MHz band can input 10 MHz digits.

 • Band edge frequency settings
Command: 02*, 1E 01, 1E 03
q
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*  When obtaining the edge number (by command “02”), 
the edge number (q) is not returned.

 • Codes for CW message contents
Command: 17 Up to 30 characters
 To send CW messages, use the following character 
codes.

Character ASCII code
0 ~ 9 30 ~ 39
A ~ Z 41 ~ 5A
a ~ z 61 ~ 7A

/ 2F
? 3F
. 2E
− 2D
, 2C
: 3A

Character ASCII code
’ 27
( 28
) 29
= 3D
+ 2B
” 22

@ 40
Space 20

L“FF” stops sending CW messages.
L “^” is used to transmit a string of characters with no  

inter-character space.
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 D Command formats (Continued)

 • Memory content
Command: 1A 00

0

1413

X X X ∙∙∙∙∙∙ X X X X X X X X X X X 0 X X X X X XX X X XX X X X

XXXX XX

X X X XX XX X X XX X

X X ∙∙∙∙∙∙ X X ∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙ ∙∙∙∙∙∙X X X XX X ∙∙∙∙∙∙ X XX X ∙∙∙∙∙∙ X X

1 2, 3 4 10, 11 24125 ~  9 15 ~  17

25 ~  27 28 ~  35 36 ~  43 44 ~  51 5 ~  51 52 ~  67

18 ~  20 21 ~  23

q Frequency band setting
01 : 144 MHz frequency band
02 : 430 MHz frequency band
03 : 1.2 GHz frequency band

w, e Memory channel number
0001 ~ 0099: Memory channel 1 to 99
0100, 0101: Program Scan Edge channel 1A, 1B
0102, 0103: Program Scan Edge channel 2A, 2B
0104, 0105: Program Scan Edge channel 3A, 3B
0106, 0107: Call channel C1, C2

r Select memory setting

0 X

e

0=OFF*

Fixed
1=1
2=2
3=3

*  For program scan edge channel, call channel,  
set to “0.”

t ~ o Operating frequency setting
See “Operating frequency.” (p. 13)
!0, !1 Operating mode setting
See “Operating mode.” (p. 13)

!2 Data mode setting
1 byte data (XX)
00: Data mode OFF
01: Data mode ON

!3 Duplex and Tone settings

X X

13

0=Duplex OFF
1=Duplex−
2=Duplex+
3=RPS*

0=OFF
1=TONE
2=TSQL
3=DTCS

*  RPS can be set when DD mode is selected, and 
DUP (+, -) can be set when other than DD mode is 
selected.

!4 Digital squelch setting

X 0

!4

0=Digital squelch function OFF
1=Digital call sign squelch function ON (DSQL)
2=Digital code squelch function ON (CSQL)

Fixed

!5 ~ !7 Repeater tone frequency setting
!8 ~ @0 Tone squelch frequency setting
See “ Repeater tone/tone squelch frequency 

setting.” (p. 20)

@1 ~ @3 DTCS code setting
See “ DTCS code and polarity setting.” (p. 20)

@4 DV Digital code squelch setting
See “DV Digital code squelch setting.” (p. 20)

@5 ~ @7 Duplex offset frequency setting
See “Duplex Offset frequency setting.” (p. 13)

@8 ~ #5  UR (Destination) call sign setting 
(8 characters; fixed)

#6 ~ $3  R1 (Access repeater) call sign setting 
(8 characters; fixed)

$4 ~ %1  R2 (Gateway/Link repeater) call sign setting 
(8 characters; fixed)

See “DV TX call signs setting.” (p. 20)

%2 ~ ^7  Memory name setting 
(16 characters; fixed)

See “Codes for character entries.” (p. 15)

To clear the memory channel contents on 1A 00:
w, e :Memory channel (0001~0099)
r : “FF,” t ~ :None

NOTE:
• The same data as t ~ %1 are stored in t ~ %1.
•  When the Split function is ON, the data of t ~ %1 is 

used for transmit.
•  Even if the Split function is OFF, enter the data into t ~ 
%1 to match your transceiver. We recommend that you 
set the same data as t ~ %1.

Remote control

14



 D Command formats (Continued)

 • Band stacking register
Command: 1A 01

q

XX X X

w

NOTE:
When sending the contents, the codes, such as operating 
frequency and operating mode*, should be added after 
the frequency band code and the register code, as shown 
below.
*  See t to %1 on ‘Memory content setting.’ (p. 14)

q Frequency band codes
Code Freq. band Frequency range (unit: MHz)

01 VHF    144.000000 ~   148.000000
02 UHF    430.000000 ~   450.000000
03 1.2GHz 1240.000000 ~ 1300.000000

w Register codes
Code Registered number

01 1 (Display on left side)
02 2 (Display in center)
03 3 (Display on Right side)

To read the contents, the register code should be 
added after the frequency band code, as shown 
below.
Example: When reading the frequency displayed in 
the center of the display in the VHF band, use code 
“0202.”

 • Codes for character entries
Command:  1A 00,  

1A 05  0144, 0151, 0182, 0259,  
0279, 0281, 0293, 0316

 1A 05 0262 ~ 1A 05 0265,  
1A 05 0268 ~ 1A 05 0271

- Character codes— Letters and Numbers
Character ASCII code Character ASCII code

A ~ Z 41 ~ 5A a ~ z 61 ~ 7A
0 ~ 9 30 ~ 39

- Character codes— Symbols
Character ASCII code Character ASCII code

! 21 # 23

$ 24 % 25
& 26 \ 5C
? 3F ” 22
’ 27 ` 60
^ 5E + 2B
− 2D * 2A
/ 2F . 2E
, 2C : 3A
; 3B = 3D
< 3C > 3E
( 28 ) 29
[ 5B ] 5D
{ 7B } 7D
| 7C _ 5F
͂ 7E @ 40

Command Set item/selectable characters
1A 00 Memory name

All characters are usable.
1A 05 0144 SET > Network > Network Name

(up to 15 characters)
0151 SET > Network > Network Radio Name

(up to 16 characters)
0182 SET > Time Set > Date/Time > 

NTP Server Address

 • Memory keyer character entries
Command: 1A 02
- Character codes

Character
ASCII 
code

Description

0 ~ 9 30 ~ 39 Numbers
A ~ Z 41 ~ 5A Letters
space 20 Word space

/ 2F Symbol
? 3F Symbol
, 2C Symbol
. 2E Symbol

@ 40 Symbol
^ 5E Example:  to send ‒BT

―,  
enter ^4254

* 2A Inserts contest number  
(can be used for 1 channel only)
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 D Command formats (Continued)

 • IF filter width settings
Command: 1A 03

Mode Data Steps
SSB/CW/RTTY 0 to 9 50 ~ 500 Hz (50 Hz)

SSB/CW 10 to 40 600 Hz ~ 3.6 kHz (100 Hz)
RTTY 10 to 31 600 ~ 2.7 kHz (100 Hz)
AM 0 to 49 200 Hz ~ 10.0 kHz (200 Hz)

 • AGC time constant settings
Command: 1A 04

Data
AGC time constant (sec.)

SSB/CW/RTTY AM
0 OFF OFF
1 0.1 0.3
2 0.2 0.5
3 0.3 0.8
4 0.5 1.2
5 0.8 1.6
6 1.2 2.0
7 1.6 2.5
8 2.0 3.0
9 2.5 4.0

10 3.0 5.0
11 4.0 6.0
12 5.0 7.0
13 6.0 8.0

 •  SSB/SSB-DATA transmission passband width 
settings

Command: 1A 05 0017 ~ 1A 05 0020

XX Higher edge
0= 2500 Hz 
1= 2700 Hz 
2= 2800 Hz 
3= 2900 Hz

Lower edge
0= 100 Hz 
1= 200 Hz 
2= 300 Hz 
3= 500 Hz

Lower edge

Higher edge

 • RX HPF/LPF setting for each operating mode
Command: 1A 05  0001, 0004, 0007,  

0010, 0013, 0014
X X X X

*The value of the HPF should be smaller than the LPF.

HPF (Lower edge)
00=Through
01 ~ 20=100 ~ 2000 Hz

LPF(Upper edge)
05 ~ 24=500~2400 Hz
25=Through

 • Color settings
Command: 1A 05  0194, 0195, 0196, 0212, 0214, 

0230, 0235, 0236
q

0 X X X 0 X X X 0 X X X

w e r t y

R (Red)
0000 ~ 0255

G (Green)
0000 ~ 0255

B (Blue)
0000 ~ 0255

 • Memory keyer content
Command: 1A 02

X

q: Channel data
01=M1 05=M5
02=M2 06=M6
03=M3 07=M7
04=M4 08=M8

w ~ &1: Text data

X X X …… X X

 • UTC Offset setting
Command: 1A 05 0184

Shift direction
00=+ (plus)
01=− (minus)

Offset time
0000 ~ 1400

XX X X XX

 • Split offset frequency setting
Command: 1A 05 0044
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q

0X X X X

w e

0

r

X X

 • Scope VBW (Video Band Width) settings
Command: 1A 05 0191, 27 1D

00=Narrow
01=Wide

00=MAIN
01=SUB

XX X X
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 D Command formats (Continued)

 • Bandscope edge frequency settings
Command:  1A 05 0202 ~ 1A 05 0210 

1A 05 0348 ~ 1A 05 0350
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 • Manually entered position data
Command: 1A 05 0257, 0283, 0297, 23 02

X X X X
y ~ !1

∙∙∙∙∙∙∙ X X X X
!2 ~ !5

∙∙∙∙∙∙∙X X∙∙∙∙∙∙∙X X
q ~ t
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Altitude

1

X X X X X X X 0 0 X 0 X X X X X X X X 0 0 X X X X X X X 0 X
2 3 4 5 6 7 8 9 10 11 12 13 14 15* * * *

:

q ~ t: Latitude (ddºmm.mmm format)
y ~ !1: Longitude (dddºmm.mmm format)
!2 ~ !5: Altitude (0.1 meter steps)
*  When reading the contents with no altitude, sends 
!2, !3, !4 and !5 as “FF.”

*  When sending the contents with no altitude, set 
!2, !3, !4 and !5 to “FF.”

 • Unproto Address setting
Command: 1A 05 0259
Set an unproto address of up to 56 characters.
See “Codes for character entries.” (p. 15)

 • Entering Object name or Item name
Command: 1A 05 0279, 0293
Enter an Object or Item name of up to 9 characters.
See “Codes for character entries.” (p. 15)

 • D-PRS Symbol setting
Command:  1A 05 0262 ~ 1A 05 0265,  

1A 05 0281, 0295, 0306

First digit Second digit

XX X X

 ⁄, \, 0 to 9, A to Z can be used for the first digit 
character.
See “Codes for character entries” for the second 
digit character. (p.15)

 • D-PRS Comment setting
Command:  1A 05 0268 ~ 1A 05 0271 

1A 05 0282, 0296, 0308
Set a comment of up to 43 characters.
See “Codes for character entries.” (p. 15)

 • GPS message setting
Command: 1A 05 0316
Set a GPS message of up to 20 characters.
See “Codes for character entries.” (p. 15)

 • Alarm area (Group) setting
Command: 1A 05 0317

q

XX X X 0

w e

X
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. d
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 9

0.
01
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 ~
 9

0.
00

1 
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it:

 0
 ~

 9

0 
(fi

xe
d)

 • [VOX/BK-IN] setting
Command: 1A 05 0343

Data Function

00 VOX/BK-IN

01 CD

02 PRESET

03 Home CH

04 Temporary Skip

05 Voice/Keyer/RTTY Memory 1

06 Voice/Keyer/RTTY Memory 2

07 Voice/Keyer/RTTY Memory 3

08 Voice/Keyer/RTTY Memory 4

Remote control
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 D Command formats (Continued)

 • [AUTOTUNE/AFC] setting
Command: 1A 05 0344

Data Function

00 AUTOTUNE/AFC

01 AUTOTUNE/AFC/RX>CS

02 TONE/RX>CS

03 CD

04 CD/RX>CS

05 PRESET

06 PRESET/RX>CS

07 Home CH

08 Home CH/RX>CS

09 Temporary Skip

10 Temporary Skip/RX>CS

11 Voice/Keyer/RTTY Memory 1

12 Voice/Keyer/RTTY Memory 2

13 Voice/Keyer/RTTY Memory 3

14 Voice/Keyer/RTTY Memory 4

 • [TONE/RX>CS] setting
Command: 1A 05 0345

Data Function

00 AUTOTUNE/AFC

01 TONE/RX>CS

02 CD/RX>CS

03 PRESET/RX>CS

04 Home CH/RX>CS

05 Temporary Skip/RX>CS

 • MIC Key Customize setting
Command: 1A 05 0346, 0347

Data Function

00 No function

01 UP

02 DOWN

03 UP (VFO: kHz)

04 DOWN (VFO: kHz)

05 XFC

06 CALL

07 VFO/MEMO

08 DR

09 FROM/TO (DR)

10 Home CH

11 BAND UP

12 BAND DOWN

13 SCAN

14 Temporary Skip

15 SPEECH

16 MAIN/DUAL

17 MODE

18 Voice/Keyer/RTTY Memory 1

19 Voice/Keyer/RTTY Memory 2

20 Voice/Keyer/RTTY Memory 3

21 Voice/Keyer/RTTY Memory 4

22 T-CALL

23 RX>CS

24 TS

25 MPAD

26 SPLIT

27 A/B

 • Data mode with filter width settings
Command: 1A 06

q

X X X X

w

01=FIL1
02=FIL2
03=FIL3

00=Data mode OFF*
01=Data mode ON

*When 00 is set, also set 00 to w.
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 D Command formats (Continued)

 • Satellite memory content setting
Command: 1A 07
1, 2 8, 93 ~  7

3 ~  46

13 ~  15

31 ~  38 47 ~  5539 ~  46

16 ~  18 19 ~  21 23 ~  30

X

10 12 2211

X ∙∙∙∙∙∙ X X X X X X X X 0 X X 0 X X X X X XX XX X X XX X X XX XX X X XX X

X X ∙∙∙∙∙∙ X X ∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙ ∙∙∙∙∙∙X X X XX X ∙∙∙∙∙∙ X X

X X ∙∙∙∙∙∙ X X

∙∙∙∙∙∙∙∙∙∙∙∙

q, w Satellite memory channel number
0001 ~ 0099: Satellite memory channel 1 to 99

e ~ u Operating frequency setting
See “Operating frequency.” (p. 13)

i, o Operating mode setting
See “Operating mode.” (p. 13)

!0 Data mode setting
1 byte data (XX)
00: Data mode OFF
01: Data mode ON

!1 Tone settings

0 X

11

0=OFF
1=TONE
2=TSQL
3=DTCS

Fixed

!2 Digital squelch setting

X 0

!2

0=Digital squelch function OFF
1=Digital call sign squelch function ON (DSQL)
2=Digital code squelch function ON (CSQL)

Fixed

!3 ~ !5 Repeater tone frequency setting
!6 ~ !8 Tone squelch frequency setting
See “Repeater tone/tone squelch frequency 
setting.” (p. 20)

!9 ~ @1 DTCS code setting
See “ DTCS code and polarity setting.” (p. 20)

@2 DV Digital code squelch setting
See “DV Digital code squelch setting.” (p. 20)

@3 ~ #0  UR (Destination) call sign setting 
(8 characters; fixed)

#1 ~ #8  R1 (Access repeater) call sign setting 
(8 characters; fixed)

#9 ~ $6  R2 (Gateway/Link repeater) call sign setting 
(8 characters; fixed)

See “DV TX call signs setting.” (p. 20)

$7 ~ ^7  Memory name setting 
(16 characters; fixed)

See “Codes for character entries.” (p. 15)

NOTE:
• The same data as e ~ $6 are stored in e ~ $6.
•  e ~ $6 is used for the uplink frequency (transmit).
•  e ~ $6 is used for the downlink frequency (receive).
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 • Repeater tone/tone squelch frequency settings
Command: 1B 00, 1B 01
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0.
1 

H
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t: 
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9
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di
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0*

Fi
xe

d 
di

gi
t: 

0*

q*

00 X X X

w e

X

*Not necessary when setting a frequency.

 D Command formats (Continued)

 •  DTCS code and polarity setting
Command: 1B 02

0 
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d)
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Receive polarity: 0=Normal
 1=Reverse
Transmit polarity: 0=Normal
  1=Reverse

q

XX 0 X X

w e

X

 •  DV Digital code squelch setting
Command: 1B 07
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 ~
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t: 
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~ 
9

q

XX

 • DV MY call sign setting
Command: 1F 00
Set your own call sign and note of up to 12 characters.
See “Character’s code of the call sign.”

X X X X X X X X X X X X
o ~ !2q ~ i

∙∙∙∙∙∙∙∙

q ~ i: Your own call sign setting (8 characters)
o ~ !2: Note setting (4 characters)

 • DV TX call signs setting (24 characters)
Command: 1F 01
Set “UR,” “R1” and “R2” call signs of 8 characters 
(fixed).
See “Character’s code of the call sign.”

X X∙∙∙∙∙∙∙∙X X X X X X X X X X∙∙∙∙∙∙∙∙

!7 ~ @4o ~ !6q ~ i
∙∙∙∙∙∙∙∙

q ~ i:  UR (Destination) call sign setting  
(8 characters)

o ~ !6:  R1 (Access/Area repeater) call sign setting  
(8 characters)

!7 ~ @4:  R2 (Link/Gateway repeater) call sign setting  
(8 characters)

Character’s code of the call sign
Character ASCII code

0 ~ 9 30 ~ 39
A ~ Z 41 ~ 5A

(Space) 20
/ 2F

 • DV TX message setting
Command: 1F 02
Set the transmit message of up to 20 characters.
“FF” stops sending or reading messages.

Character ASCII code Character ASCII code
A ~ Z 41 ~ 5A a ~ z 61 ~ 7A
0 ~ 9 30 ~ 39 Space 20

! 21 # 23
$ 24 % 25
& 26 \ 5C
? 3F " 22
’ 27 ` 60
^ 5E + 2B
– 2D * 2A
/ 2F . 2E
, 2C : 3A
; 3B = 3D
< 3C > 3E
( 28 ) 29
[ 5B ] 5D
{ 7B } 7D
¦ 7C _ 5F
¯ 7E @ 40
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 • DV RX call sign data
Command: 20 0001, 20 0002

X X X X X XXX X X X X∙∙∙∙∙∙X XXX ∙∙∙∙∙∙

X X∙∙∙∙∙∙X X X X∙∙∙∙∙∙X X

1, 2 3 ~  10 11 ~  14 15 ~  22

23 ~  30 31 ~  38

q Header flag data (First byte)
Data Description

bit7 (0: Fixed) —
bit6 (0: Fixed) —
bit5 (0: Fixed) —
bit4 0/1 0=Voice, 1=Data
bit3 0/1 0=Direct, 1=Through repeater
bit2 0/1 0=No Break-in, 1=Break-in
bit1 0/1 0=Data, 1=Control
bit0 0/1 0=Normal, 1=EMR

w Header flag data (Second byte)
Data Descriptionbit2 bit1 bit0

1 1 1 Repeater control
1 1 0 Send auto acknowledge
1 0 1 (Not used)
1 0 0 Request to re-transmit
0 1 1 Send acknowledge
0 1 0 Receive no reply
0 0 1 Repeater disabled
0 0 0 NULL

e ~ !0:  Call sign of the caller station 
(8 characters, fixed)

!1 ~ !4:  Note of the caller station  
(4 characters, fixed)

!5 ~ @2:  Call sign of the called station 
(8 characters, fixed)

@3 ~ #0:  Call sign of the access/area repeater (R1)  
(8 characters, fixed)

#1 ~ #8:  Call sign of the link/gateway repeater (R2) 
(8 characters, fixed)

LFF:  When no call sign is received since the transceiver 
power was turned ON.

 D Command formats (Continued)

 • DV RX message
Command: 20 0101, 20 0102

X X X XXX X X∙∙∙∙∙∙X X∙∙∙∙∙∙X X
1 ~  20 21 ~  28 29 ~  32

q ~ @0: Message (20 characters)
@1 ~ @8: Call sign of the caller station (8 characters)
@9 ~ #2: Note of the caller station (4 characters)
See “Codes for character entries.” (p. 15)
LFF:  When no call sign is received since the transceiver 

power was turned ON.

Example: When a Gateway call is received

RXRPT2

RXRPT1
GW

CALLED

YOUR STATION

CALLER

JG3LUK calling to JM1ZLK on JP3YHH port A...

JG3LUK calling to 

JM1ZLK on 

JP3YHH port A...

INTERNETINTERNET

JG3LUK calling to 
JM1ZLK on 
JP3YHH port A...

CALLER: Caller’s call sign
CALLED: Called station call sign
RXRPT1:  Call sign of the repeater that was 

accessed by the caller station
L If it was a call through a gateway and the 

internet, this item displays the gateway call 
sign of the repeater you received the call from.

RXRPT2:  Call sign of the repeater you received the 
call from

 • DV RX Status setting
Command: 20 0201, 20 0202

Data Function Description
bit7 0 (Fixed) —

bit6 0/1 Receiving a 
voice call

While receiving a digital 
voice signal, select “1.” 
(Regardless of DSQL and 
CSQL setting)

bit5 0/1 Last call 
finisher

When the last call was 
finished by you, select “1.”

bit4 0/1 Receiving a 
signal

When the audio tone can 
be heard, select “1.”

bit3 0/1 Receiving a 
BK call

While receiving a BK call, 
select “1.”

bit2 0/1 Receiving a 
EMR call

While receiving a EMR call, 
select “1.”

bit1 0/1
Receiving a 
signal other 
than DV

When “DV” and “FM” are 
blinking, select “1.”

bit0 0/1 Packet loss 
status

While displaying packet 
loss, “1” is returned.
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 D Command formats (Continued)

 • GPS/D-PRS data
Command: 20 03  0100, 0200, 0101, 0201, 0102, 0202, 0103, 0203

Data number and description
Data number Description

00 D-PRS— Position

01 D-PRS— Object

02 D-PRS— Item

03 D-PRS— Weather

Position
Command: 20 03 0100, 0200

X X X X X X X X

X X X X

X X X X

X

0 0 X X X X∙∙∙∙∙∙
1 ~  9 10    11

39 40 41 42

X X X X∙∙∙∙∙∙
12 ~  16

X X X X∙∙∙∙∙∙

17 ~  22
X X X X∙∙∙∙∙∙

23 ~  26 27    28

X X X∙∙∙∙∙∙

29 ~  31
X X X X∙∙∙∙∙∙

32 ~  38

Data number

q ~ o: Call sign/SSID
   (9 ASCII characters (A ~ Z, 0 ~ 9, /, -, space))
!0, !1: Symbol
   (2 ASCII characters (00h ~ EFh))
!2 ~ !6: Latitude (ddºmm.mmm format)
!7 ~ @2: Longitude (dddºmm.mmm format)
@3 ~ @6: Altitude (0.1 meter steps)
@7, @8: Course (1 degree steps)
@9 ~ #1: Speed (0.1 km/h steps)
#2 ~ #8: Date (UTC: yyyymmddHHMMSS)
   ( y: Year, m: Month, d: Day, H: Hour, M: Minute,  

S: Second)
#9:  Power (see the table below)
$0:  Height (see the table below)
$1:  Gain (see the table below)
$2:  Directivity (see the table below)

Power Height Gain Directivity
Data (W) (m/ft) (dB) (deg)

0 0 3/10 0 Omni-direction
1 1 6/20 1 45º NE
2 4 12/40 2 90º E
3 9 24/80 3 135º SE
4 16 49/160 4 180º S
5 25 98/320 5 225º SW
6 36 195/640 6 270º W
7 49 390/1280 7 315º NW
8 64 780/2560 8 360º N
9 81 1561/5120 9 —

L The item, that is not contained the received data, is 
filled with “FF.”
LFF:  No signal has been received since the power was 

turned ON.

Object
Command: 20 03 0101, 0201

X X X X X X

X X

X X X X

X X X X X X X X∙∙∙∙∙∙
10    11

39

X X

52

40 41

42

12 ~  16

X X X X∙∙∙∙∙∙

17 ~  22
X X X X∙∙∙∙∙∙

23 ~  26 27 28

0 1 X X X X∙∙∙∙∙∙
1 ~  9

X X X X∙∙∙∙∙∙

29 ~  31
X X X X∙∙∙∙∙∙

32 ~  38

X X X X∙∙∙∙∙∙

43 ~  51

Data number

q ~ o: Call sign/SSID
   (9 ASCII characters (A ~ Z, 0 ~ 9, /, -, space))
!0, !1: Symbol
   (2 ASCII characters (00h ~ EFh))
!2 ~ !6: Latitude (ddºmm.mmm format)
!7 ~ @2: Longitude (dddºmm.mmm format)
@3 ~ @6: Altitude (0.1 meter steps)
@7, @8: Course (1 degree steps)
@9 ~ #1: Speed (0.1 km/h steps)
#2 ~ #8: Date (UTC: yyyymmddHHMMSS)
   ( y: Year, m: Month, d: Day, H: Hour, M: Minute,  

S: Second)
#9:  Power (see the table below)
$0:  Height (see the table below)
$1:  Gain (see the table below)
$2:  Directivity (see the table below)

Power Height Gain Directivity
Data (W) (m/ft) (dB) (deg)

0 0 3/10 0 Omni-direction
1 1 6/20 1 45º NE
2 4 12/40 2 90º E
3 9 24/80 3 135º SE
4 16 49/160 4 180º S
5 25 98/320 5 225º SW
6 36 195/640 6 270º W
7 49 390/1280 7 315º NW
8 64 780/2560 8 360º N
9 81 1561/5120 9 —

$3 ~ %1:  Name
   (9 ASCII characters (00h ~ EFh))
%2:  Type (1= Live, 0= Killed)

L The item, that is not contained the received data, is 
filled with “FF.”
LFF:  No signal has been received since the power was 

turned ON.
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 D Command formats
• GPS/D-PRS data (Continued)
Item
Command: 20 03 0102, 0202

X X X X X X

X X X X

X X X X

X X X

10    11

3332

X X

45

34 35

X X X X∙∙∙∙∙∙
12 ~  16

X X X X∙∙∙∙∙∙

17 ~  22
X X X X∙∙∙∙∙∙

23 ~  26 27

X X X∙∙∙∙∙∙

29 ~  31

X X X X∙∙∙∙∙∙

36 ~  44

28

0 2 X X X X∙∙∙∙∙∙
1 ~  9

Data number

q ~ o: Call sign/SSID
   (9 ASCII characters (A ~ Z, 0 ~ 9, /, -, space))
!0, !1: Symbol
   (2 ASCII characters (00h ~ EFh))
!2 ~ !6: Latitude (ddºmm.mmm format)
!7 ~ @2: Longitude (dddºmm.mmm format)
@3 ~ @6: Altitude (0.1 meter steps)
@7, @8: Course (1 degree steps)
@9 ~ #1: Speed (0.1 km/h steps)
#2:  Power (see the table below)
#3:  Height (see the table below)
#4:  Gain (see the table below)
#5:  Directivity (see the table below)

Power Height Gain Directivity
Data (W) (m/ft) (dB) (deg)

0 0 3/10 0 Omni-direction
1 1 6/20 1 45º NE
2 4 12/40 2 90º E
3 9 24/80 3 135º SE
4 16 49/160 4 180º S
5 25 98/320 5 225º SW
6 36 195/640 6 270º W
7 49 390/1280 7 315º NW
8 64 780/2560 8 360º N
9 81 1561/5120 9 —

#6 ~ $4: Name
   (9 ASCII characters (00h ~ EFh))
$5:  Type (1= Live, 0= Killed)

L The item, that is not contained the received data, is 
filled with “FF.”
LFF:  No signal has been received since the power was 

turned ON.

Weather
Command: 20 03 0103, 0203

X X X X X X

X X X X
10    11

X X X X∙∙∙∙∙∙
12 ~  16

X X X X∙∙∙∙∙∙

17 ~  22
X X X X∙∙∙∙∙∙

23 ~  29 30 31 32

0 3 X X X X∙∙∙∙∙∙
1 ~  9

X X

33

X X X X

34 35

X X X X X X

X X

39 40 41

42

X X X X∙∙∙∙∙∙

36 ~  38

X X X X

43 44

X X X X

45 46

X X X X∙∙∙∙∙∙

47 ~  49

Data number

q ~ o: Call sign/SSID
    (9 ASCII characters (A ~ Z, 0 ~ 9, /, -, space))
!0, !1: Symbol
     (2 ASCII characters (00h ~ EFh))
!2 ~ !6: Latitude (ddºmm.mmm format)
!7 ~ @2: Longitude (dddºmm.mmm format)
@3 ~ @9: Date (UTC: yyyymmddHHMMSS)
    ( y: Year, m: Month, d: Day, H: Hour, M: Minute,  

S: Second)
#0, #1: Wind direction (1 degree steps)
#2, #3: Wind speed (0.1 m/s steps)
#4, #5: Gust speed (0.1 m/s steps)
#6 ~ #7: Temperature (0.1ç steps)
#8  : Temperature  (0= + degree, 1= – degree)
#9, $0: Rainfall (0.1 mm steps)
$1, $2: Rainfall (24 hours) (0.1 mm steps)
$3, $4: Rainfall (Midnight) (0.1 mm steps)
$5, $6: Humidity (1% steps)
$7 ~ $9: Barometric pressure (0.1 hPa steps)

L The item, that is not contained the received data, is 
filled with “FF.”
LFF:  No signal has been received since the power was 

turned ON

 • GPS/D-PRS message 
Command: 20 0401, 0402

q ~ o !0 ~ %2

(Variable length)
• • • • • • X XX X X XX X

q ~ o: Call sign/SSID
   (9 ASCII characters (A ~ Z, 0 ~ 9, /, -, space))
!0 ~ %2: Message
   (Up to 43 ASCII characters (00h ~ EFh))
LFF:  When no call sign is received since the transceiver 

power was turned ON.
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 • RIT frequency settings
Command: 21 00

10
 H

z:
 0

 ~
 9

10
0 

H
z:
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 ~

 9

1 
H

z:
 0

 ~
 9

1 
kH

z:
 0

 ~
 9

X X X X X X

00: + (plus)
01: – (minus)

 • DV TX data
Command: 22 00

1 ~  30
X X X X∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙

(Variable length)

q ~ #0: Tx, data (Up to 30 Byte)
   (“ FA” to “FF” are entered after converted to  

“FF 0A” to “FF 0F” automatically. Up to 60 Byte 
data can be entered in this case.)

 • DV RX data (transceive)
Command: 22 0101

1 ~  30
X X X X∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙

(Variable length)

q ~ #0: Rx, data (Up to 30 Byte)
   (“ FA” to “FF” are entered after converted to  

“FF 0A” to “FF 0F” automatically. Up to 60 Byte 
data can be entered in this case.)

 • MY position data
Command: 23 00

X X X X
1 ~  5

X X X X
6 ~  11

X X X X
12 ~  15

X X X X
18 ~  20

X X X X
21 ~  2716

X X
17

X X

∙∙∙∙∙∙∙ ∙∙∙∙∙∙∙

∙∙∙∙∙∙∙ ∙∙∙∙∙∙∙

∙∙∙∙∙∙∙

q ~ t: Latitude (ddºmm.mmm format)
y ~ !1: Longitude (dddºmm.mmm format)
!2 ~ !5: Altitude (0.1 meter steps)
!6, !7: Course (1 degree steps)
!8 ~ @0: Speed (0.1 km/h steps)
@1 ~ @7: Date (UTC: yyyymmddHHMMSS)
   ( y: Year, m: Month, d: Day, H: Hour, M: Minute,  

S: Second)

 •  Selected or unselected VFO frequency settings 
(Only MAIN band)

Command: 25
X X X X X X X X X X X X

Operating frequency*00=Selected VFO
 01=Unselected VFO

LYou cannot set the SUB band frequency.
* 00/01 can be set in the VFO mode. (In the satellite 
mode, “FA” (NG) is returned.)

In the memory channel mode, call channel mode, 
or DR function, the transceiver returns “FA” (NG) 
because these cannot be set to 01.
•When VFO A is selected
00=frequency of VFO A changes
01=frequency of VFO B changes
•When VFO B is selected
00=frequency of VFO B changes
01=frequency of VFO A changes

See “Operating frequency.” (p. 13)

 •  Selected or unselected VFO’s operating mode 
and filter settings (Only MAIN band)

Command: 26
LYou cannot set the SUB band operating mode and filter settings.
Both data and filter settings can be skipped. In that 
case, “DATA OFF” and the default filter setting of 
the operating mode is automatically selected.

1Operating mode setting

2Data mode setting

3Filter setting
*00=Selected VFO
 01=Unselected VFO

XX X X XX XX

* 00/01 can be set in the VFO mode. (In the satellite 
mode, “FA” (NG) is returned.)

In the memory channel mode, call channel mode, 
or DR function, the transceiver returns “FA” (NG) 
because these cannot be set to 01.
•When VFO A is selected
00=operating mode of VFO A changes
01=operating mode of VFO A changes of VFO B changes
•When VFO B is selected
00=operating mode of VFO A changes of VFO B changes
01=operating mode of VFO A changes of VFO A changes
q Operating mode  

setting
w Data mode 

setting
e Filter  

setting
00:LSB 05:FM 00: Data mode OFF*2 01:FIL1
01:USB 07:CW-R 01: Data mode ON 02:FIL2
02:AM 08:RTTY-R — 03:FIL3
03:CW 17:DV — —
04:RTTY 22:DD*1 — —

*1  22 Command (DD) can be selected when setting the 
1200 MHz band to other than the satellite mode.

*2  When 00 is set, also set 00 to e.

 D Command formats (Continued)
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 D Command formats (Continued)

 • Scope waveform data
Command: 27 00
Outputs the waveform data to the controller.

X XX XX X X XX X

1 2 3 4 5

X X X X ...... X X

6 7

...... X X

q Main or Sub scope data
 • 00=Main scope, 01=Sub scope
w Order of division data (Current): 01~11
e Division number (Maximum): 01(LAN), 11(USB)
  When data is sent to the controller through the 

LAN port, all data is sent together. However, 
when the data is sent through the USB port, the 
data is divided by 11 and sent in sequential order.

  The 1st data sends only the wave information (q ~ 
y) without the waveform data (u).

  The 2nd or later data sends the minimum wave 
information (q ~ e) with waveform data (u).

r Center or Fixed mode data
 • 00 = Center mode scope
  01 = Fixed mode scope
  02 = SCROLL-C mode scope
  03 = SCROLL-F mode scope

t Waveform information
  The waveform information differs, depending on 

the Spectrum scope mode.
 •  In the Center mode:  

Center frequency and span are sent.
    See page 13 of the CI-V Reference Guide for 

Operating frequency data, and the Scope span 
settings w ~ y.

 •  In the Fixed, SCROLL-C, and SCROLL-F modes: 
Lower edge and higher edge frequencies are sent.

    See the Scope Fixed edge frequency settings e ~ !2 

on page 26.

y Out of range information
 • 00 = In range, 01 = Out of range
   If the scope data is out of range, the waveform data 

(u) is omitted.

u Waveform data
  The transceiver outputs the drawn waveform data.
  The data range or data length of the waveform data is 

judged by the controller. (The data range is basically 
the same as the display size of the scope on the 
controller.)

Data range 0 ~ 160

Data length 475

 • Spectrum scope mode settings
Command: 27 14

X X X X

00=Center mode
01=Fixed mode
02=SCROLL-C mode
03=SCROLL-F mode

00=MAIN
01=SUB

 • Scope span settings
Command: 27 15

X X 0 0 X X X X 0 0 0 0

00=MAIN
01=SUB
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w e r t y  Span (kHz)
2500 2.5
5000 5

10000 10
25000 25
50000 50

100000 100 
250000 250
500000 500

 • Scope Edge number settings
Command: 27 16

X X X X

01=Edge 1
02=Edge 2
03=Edge 3
04=Edge 4

00=MAIN
01=SUB

 • Scope Hold settings
Command: 27 17

X X X X

00=Hold OFF
01=Hold ON

00=MAIN
01=SUB

 • Scope Reference level settings
Command: 27 19
Common settings for the Main and Sub scopes.

X X X X X 0 X X

00= + (plus)
01= – (minus)

00=Main scope
01=Sub scope

10
 d

B
 d

ig
it:

 0
, 1

, 2
1 

dB
 d

ig
it:

 0
 ~

 9
0.

1 
dB

 d
ig

it:
 0

, 5
0.

01
 d

B
 d

ig
it:

 0
(F

ix
ed

)

L Adjustable range: –20.0 dB ~ +20.0 dB in 0.5 dB steps.

Remote control

25



 D Command formats (Continued)

 • Scope Sweep speed settings
Command: 27 1A

X X X X

00=FAST
01=MID
02=SLOW

00=MAIN
01=SUB

 • Scope Fixed edge frequency settings
Command: 27 1E
q

0 XX X X

w e r t y u i o !0 !1 !2

X X X X X X X X X X X X X X X X X X X
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L Entry of less than 1 kHz digits is ignored.

q Selectable Frequency ranges
Data Frequency range (MHz)
01   144.000 ~  148.000
02  430.000 ~  450.000
03  1240.000 ~ 1300.000

w Selectable Edge number: 01=1, 02=2, 03=3, 04=4
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